## Content

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Getting Started.</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>SAP S/4HANA System Landscape Information.</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>Installation Documentation.</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>Product and Database Information.</td>
<td>11</td>
</tr>
<tr>
<td>5</td>
<td>Maintenance Planner.</td>
<td>14</td>
</tr>
<tr>
<td>6</td>
<td>Installation Process.</td>
<td>15</td>
</tr>
<tr>
<td>7</td>
<td>Installation Follow-Up Activities.</td>
<td>16</td>
</tr>
<tr>
<td>7.1</td>
<td>Applying the Latest Kernel and Support Package Stacks.</td>
<td>16</td>
</tr>
<tr>
<td>7.2</td>
<td>Importing Data to SAP S/4HANA.</td>
<td>17</td>
</tr>
<tr>
<td>7.2.1</td>
<td>SAP S/4HANA Migration Cockpit.</td>
<td>17</td>
</tr>
<tr>
<td>7.2.2</td>
<td>SAP Data Services.</td>
<td>20</td>
</tr>
<tr>
<td>7.3</td>
<td>System Configuration for SAP S/4HANA.</td>
<td>20</td>
</tr>
<tr>
<td>7.4</td>
<td>Installation of SAP Fiori.</td>
<td>21</td>
</tr>
<tr>
<td>7.5</td>
<td>User Assistance Settings.</td>
<td>22</td>
</tr>
<tr>
<td>7.5.1</td>
<td>Enable Context-Sensitive User Assistance and Back-End Help Links.</td>
<td>23</td>
</tr>
<tr>
<td>7.6</td>
<td>Configure the SAP Web Dispatcher.</td>
<td>26</td>
</tr>
<tr>
<td>7.7</td>
<td>Installation of a Digital Assistant.</td>
<td>28</td>
</tr>
<tr>
<td>7.8</td>
<td>Installation of the PI Adapters for Elster and Swift.</td>
<td>28</td>
</tr>
<tr>
<td>7.9</td>
<td>Creating RFC Destinations for liveCache Applications.</td>
<td>29</td>
</tr>
<tr>
<td>7.10</td>
<td>Follow-Up Activities for Advanced Variant Configuration.</td>
<td>30</td>
</tr>
<tr>
<td>7.10.1</td>
<td>Follow-Up Activities for Predictive Analytics integrator.</td>
<td>33</td>
</tr>
<tr>
<td>7.10.1.1</td>
<td>ABAP Technical Jobs.</td>
<td>34</td>
</tr>
<tr>
<td>7.10.1.2</td>
<td>Setting up the OData Service.</td>
<td>35</td>
</tr>
<tr>
<td>7.10.1.3</td>
<td>Setting up the bgRFC Queue.</td>
<td>39</td>
</tr>
<tr>
<td>7.10.1.4</td>
<td>Configuring Business Roles for the Backend.</td>
<td>40</td>
</tr>
<tr>
<td>7.10.1.5</td>
<td>Configuring Business Roles for the Frontend.</td>
<td>43</td>
</tr>
<tr>
<td>7.11</td>
<td>Follow-Up Activities for Analytics and Planning.</td>
<td>46</td>
</tr>
<tr>
<td>7.12</td>
<td>Follow Up Activities in Master Data Governance.</td>
<td>46</td>
</tr>
<tr>
<td>7.13</td>
<td>Follow-Up Activities for Environment, Health, and Safety.</td>
<td>47</td>
</tr>
<tr>
<td>7.14</td>
<td>Follow-Up Activities for Management of Change.</td>
<td>48</td>
</tr>
<tr>
<td>7.15</td>
<td>Follow-Up Activities for Enterprise Portfolio and Project Management.</td>
<td>48</td>
</tr>
<tr>
<td>7.15.1</td>
<td>Follow-Up Activities for SAP Portfolio and Project Management.</td>
<td>49</td>
</tr>
<tr>
<td>7.15.2</td>
<td>Follow-Up Activities for Commercial Project Management.</td>
<td>50</td>
</tr>
</tbody>
</table>
Follow-Up Activities for Product Safety and Stewardship ........................................ 62
Follow-Up Activities for Product Compliance for Discrete Industries ......................... 62
Follow-Up Activities for Product Safety and Stewardship for Process Industries ............ 63
Follow-Up Activities for Product Compliance ............................................................ 62
Follow-Up Activities for Supplier Management ......................................................... 64
Follow-Up Activities for Human Resources (Compatibility Packs) ............................ 65
   Employee-Business Partner Synchronization ...................................................... 65
FAQ ......................................................................................................................... 75
Related Notes ............................................................................................................ 75
Follow-Up Activities for SAP S/4HANA for Central Procurement ............................... 76
   Integration in SAP S/4HANA .......................................................... 76
   Integration Scenarios ......................................................................................... 76
Follow-Up Activities for Agricultural Contract Management ...................................... 79
   Integration with Oil & Gas and Commodity Management ................................... 81
   Integration with Prepayment Agreements ...................................................... 82
Follow-Up Activities for Prepayment Agreements ..................................................... 84
Follow-Up Activities for Policy Management ......................................................... 84
Follow-Up Activities for Insurance Product Engine msg.PMQ ................................. 86
Follow-Up Activities for Transportation Management .............................................. 86
Follow-Up Activities for Production Planning and Detailed Scheduling (PP/DS) .......... 87
Follow-Up Activities for Data Quality Management, version for SAP Solutions .......... 87
Follow-Up Activities for Service ............................................................................. 87
Troubleshooting ....................................................................................................... 88
Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>January 13, 2022</td>
<td>Updated section Follow-Up Activities for Environment, Health, and Safety</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[page 47].</td>
</tr>
<tr>
<td>2.0</td>
<td>February 23, 2022</td>
<td>Version for SAP S/4HANA 2021 FPS01.</td>
</tr>
<tr>
<td>2.1</td>
<td>March 03, 2022</td>
<td>Updated section Follow-Up Activities for Agricultural Contract Management</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[page 79].</td>
</tr>
</tbody>
</table>
1 Getting Started

This guide provides you with the following information about SAP S/4HANA:

- A system landscape and product overview
- A list of the tools and documentation you need for the installation
- Important follow-up activities you need to consider after the installation

**i Note**

This guide cannot be used on its own, you need to use it together with the installation guides describing the installation of Application Server Systems with the Software Provisioning Manager 2.0 tool.

You find these guides (as well as a link to the SPM tool) on the SAP Support Portal at [https://support.sap.com/sltoolset](https://support.sap.com/sltoolset) System Provisioning > System Provisioning Scenarios > Install a System using Software Provisioning Manager > Installation Option of Software Provisioning Manager 2.0 <latest SP> > Installation Guides - Application Server Systems

These installation guides are sorted by database, technical stack (ABAP and Java), and operating system platform. For the installation of SAP S/4HANA, choose the SAP HANA Database guide for your operating system (UNIX, IBM, or Windows) and the ABAP Stack.

**i Note**

Java components and databases other than SAP HANA are still installed using the 1.0 version of the Software Provisioning Manager. You find the guides for version 1.0 on the same page as those for version 2.0 (see note above), just choose Installation Option of Software Provisioning Manager 1.0 <latest SP>.
2 SAP S/4HANA System Landscape Information

There are various ways of deploying SAP S/4HANA in your new or already existing system landscape. This section describes some examples.

Example: SAP S/4HANA New Installation

A new installation of SAP S/4HANA needs to run on the SAP HANA database. It is recommended to use the SAP Solution Manager, which can run on any database. This very simple landscape can be enhanced with the SAP cloud solutions and SAP Business Suite products.

Example: SAP S/4HANA in an SAP Business Suite Landscape

It is possible to integrate SAP S/4HANA into an existing SAP Business Suite landscape by replacing the SAP ERP enhancement package product with SAP S/4HANA. When performing this conversion in your system...
landscape, you need to do some adaptations, for example you need to convert some of your existing business processes to the simplified SAP S/4HANA processes. Some of the SAP Business Suite processes are no longer supported, some have been changed, and there are also new processes. How to convert your existing processes to the SAP S/4HANA processes is described in the Simplification Item Catalog.


Example SAP Business Suite landscape with an embedded SAP S/4HANA system

More Information

For more information about SAP Fiori for SAP S/4HANA see SAP Note 2590653.
## Required Installation Documentation

<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Guide for SAP S/4HANA 2021</strong> <em>(this guide)</em></td>
<td>This document contains information relevant for the installation of SAP S/4HANA, but it does not describe the process or the installation tool. They are described in the Software Provisioning Manager guides listed below. Always find the latest version of the <strong>Installation Guide for SAP S/4HANA 2021</strong> at <a href="https://help.sap.com/s4hana_op_2021">https://help.sap.com/s4hana_op_2021</a>.</td>
</tr>
</tbody>
</table>

Installation guides describing the installation of Application Server Systems with the Software Provisioning Manager 2.0 which is part of SL Toolset 1.0. Make sure that you always use the latest SP version of the tool and guides available on the SAP Support Portal at [http://help.sap.com/sitoolset](http://help.sap.com/sitoolset).

You find these guides (as well as a link to the SPM tool) at [https://support.sap.com/sitoolset](https://support.sap.com/sitoolset) > **System Provisioning > System Provisioning Scenarios** > **Install a System using Software Provisioning Manager** > **Installation Option of Software Provisioning Manager 2.0 <latest SP>** > **Installation Guides - Application Server Systems**.

These installation guides are sorted by database, technical stack (ABAP and Java), and operating system platform. For the installation of SAP S/4HANA, choose the SAP HANA Database guide for your operating system (UNIX, IBM, or Windows) and the ABAP Stack.

### Note

Java components and databases other than SAP HANA are still installed using the 1.0 version of the Software Provisioning Manager. You find the guides for version 1.0 on the same page as those for version 2.0, just choose **Installation Option of Software Provisioning Manager 1.0 SP <latest SP>**.
<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP HANA Server Installation and Update Guide</strong></td>
<td>You need the SAP HANA Server Installation and Update Guide for the installation of the following components:</td>
</tr>
</tbody>
</table>
|                                               | ● SAP liveCache on SAP HANA  
If you plan to use the SAP S/4HANA Production Planning & Detailed Scheduling (PP/DS) application and / or the Capacity Scheduling Table (Fiori ID: F3770) and Capacity Scheduling Board (Fiori ID: F3951) apps, which are a part of SAP S/4HANA Manufacturing, it is important that you install HANA integrated liveCache, which is the HANA component SAP LCA (also called LCAPPS- or liveCache Applications plugin).  
● SAP VCH AFL  
See also SAP Note 1898497.                                                                                                                                 |
<p>| <strong>UI Technology Guide for SAP S/4HANA</strong>       | You find this guide at <a href="http://help.sap.com/hana_platform">http://help.sap.com/hana_platform</a>. For information about how to install or update these components, see the section Managing SAP HANA System Components in the guide.                                      |
|                                               | You find this guide at <a href="http://help.sap.com/hana_platform">http://help.sap.com/hana_platform</a>. For information about how to install or update these components, see the section Managing SAP HANA System Components in the guide.                                      |
| <strong>SAP S/4HANA 2021: Release Information Note</strong> | SAP Note 3015539.                                                                                                                                                                                                     |
| <strong>SAP S/4HANA 2021 Feature Package Stack 00: Additional Release Information</strong> | SAP Note 3015509.                                                                                                                                                                                                     |
| <strong>SAP S/4HANA 2021: Restriction Note</strong>        | SAP Note 3079550.                                                                                                                                                                                                     |
| <strong>SAP Fiori for SAP S/4HANA 2021: Release Information Note</strong> | SAP Note 3067553.                                                                                                                                                                                                     |
| <strong>SAP S/4HANA Foundation 2021: Release Information Note</strong> | SAP Note 2975721.                                                                                                                                                                                                     |</p>
<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP S/4HANA Add-on Note</td>
<td>SAP Note 2214409</td>
</tr>
<tr>
<td>ABAP Platform 2021 – General Information</td>
<td>SAP Note 3075227</td>
</tr>
<tr>
<td>ABAP Platform 2021 – Restrictions</td>
<td>SAP Note 3075238</td>
</tr>
<tr>
<td>Java components for SAP S/4HANA 2021 – Restrictions</td>
<td>SAP Note 3075257</td>
</tr>
</tbody>
</table>

**Additional Documentation**

<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments</th>
</tr>
</thead>
</table>
| Getting Started with SAP S/4HANA                                          | You find this guide at https://help.sap.com/s4hana_op_2021
[Discover](https://help.sap.com/s4hana_op_2021)                               |
| System copy guides using the Software Provisioning Manager 1.0 or 2.0.   | You find these guides at https://support.sap.com/sitoolset
[System Provisioning](https://support.sap.com/sitoolset)
[System Provisioning Scenarios](https://support.sap.com/sitoolset)
[Copy a System using Software Provisioning Manager](https://support.sap.com/sitoolset)
[System Copy of Software Provisioning Manager 1.0 or 2.0](https://support.sap.com/sitoolset)
<[latest SPs] System Copy Guides - Software Provisioning Manager 1.0 or 2.0](https://support.sap.com/sitoolset) |
| Requirements for other components to use certain functions in decentralized EWM on SAP S/4HANA | SAP Note 2871189 |
## Product and Database Information

This section gives an overview of the components of SAP S/4HANA 2021

### SAP S/4HANA Components

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP S/4HANA Server</strong></td>
<td>Note that client 000 is not a productive client. Includes SAP S/4HANA Foundation. As well as the SAP S/4HANA Server, this component needs to be specifically selected in the Software Provisioning Manager 2.0.</td>
</tr>
</tbody>
</table>
| **SAP Predictive Integrator**   | • APL 4 FOR HANA 2 SP03+  
• UMML4HANA 1  
For information about SAP Predictive Integrator, see https://help.sap.com/s4hana_op_2021 Use Product Assistance English SAP S/4HANA Cross Components Analytics Predictive Analytics integrator (PAi) |
| **SAP HANA Rules Framework**    | HANA RULES FRAMEWORK 1.0 |
| **SAP S/4HANA AFL**             | SAP VCH AFL 2021.00 |
| **SAP LiveCache on SAP HANA**   | SAP HANA LCAPPSS 1.00  
When configuring your SAP S/4HANA installation package through Software Provisioning Manager (SWPM), you get a screen named Configuration of SAP liveCache with SAP HANA. Here, choose to install liveCache for SAP System.  
• For SAP S/4HANA you can only choose the SAP HANA integrated liveCache.  
• You need the liveCache installation only when at least one of your applications uses it. |
| **SAP Optimizer**               | SAP SCM Optimizer 14.0 |
| **Integration for Elster**      | • ABAP Platform 2021 - Advanced Adapter Engine Extnd  
• Elster 2.1 and alternative SCV  
• UTELSTER 730 |
| **Integration for Swift**       | • ABAP Platform 2021 - Advanced Adapter Engine Extnd  
• SWIFT 622  
• UTSWIFT 730 |
<p>| <strong>ESR Content</strong>                 | ESR Content (XI CONTENT) |
| <strong>SAP EHS Expert Server</strong>       | EH&amp;S EXPERT 3.2 |</p>
<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP EHS WWI Server</td>
<td>EH&amp;S WWI 3.2</td>
</tr>
<tr>
<td>MSG.PMQ Designer</td>
<td>MSG.PM Q DESIGNER 2</td>
</tr>
<tr>
<td>MSG.PMQ XSA Content</td>
<td>XSAC_TOMATOSJ 1</td>
</tr>
<tr>
<td>MSG.PMQ Sample Content</td>
<td>MSG.PM Q SAMPLE CONTENT 806</td>
</tr>
<tr>
<td>Business Intelligence</td>
<td>For more information, see SAP Note <a href="https://help.sap.com/viewer/product/SAP_POLICY_MANAGEMENT_OVERVIEW/2021.latest/en-US">2289424</a></td>
</tr>
<tr>
<td>BI Content Extension</td>
<td>For more information, see SAP Note <a href="https://help.sap.com/viewer/product/SAP_POLICY_MANAGEMENT_OVERVIEW/2021.latest/en-US">2289424</a></td>
</tr>
<tr>
<td>SAP S/4HANA Java</td>
<td>-</td>
</tr>
<tr>
<td>Adobe Document Services</td>
<td>-</td>
</tr>
<tr>
<td>Advanced Adapter Engine Extnd</td>
<td>-</td>
</tr>
<tr>
<td>Enterprise Services Repository</td>
<td>-</td>
</tr>
<tr>
<td>Content Server</td>
<td>-</td>
</tr>
<tr>
<td>SAP Web Dispatcher</td>
<td>-</td>
</tr>
<tr>
<td>Frontend</td>
<td>-</td>
</tr>
<tr>
<td>ABAP in Eclipse</td>
<td>-</td>
</tr>
</tbody>
</table>

**i Note**


**SAP Fiori for SAP S/4HANA 2021**

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI for SAP S/4HANA</td>
<td>-</td>
</tr>
<tr>
<td>UI for HCM</td>
<td>UIHR002 100</td>
</tr>
<tr>
<td>UI for MDG</td>
<td>UIMDG001 200</td>
</tr>
<tr>
<td>Component Name</td>
<td>Comment</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>UI for TVR</td>
<td>UITRV001 300</td>
</tr>
</tbody>
</table>

SAP Multichannel Foundation for Utilities and Public Sector, UI add-on for SAP S/4HANA 1709 and higher releases

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCF UI FOR SAP S/4HANA 1709+</td>
<td>UIS4MCF 100</td>
</tr>
</tbody>
</table>

Database for SAP S/4HANA Backend

<table>
<thead>
<tr>
<th>Database for SAP S/4HANA Backend</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA (SAP HANA DATABASE 2.0)</td>
<td>Used as database for SAP S/4HANA backend; can also be used by SAP Fiori for SAP S/4HANA in an embedded and in a hub deployment (see table below).</td>
</tr>
</tbody>
</table>

Databases for SAP Fiori for SAP S/4HANA (Frontend)

<table>
<thead>
<tr>
<th>Databases for SAP Fiori for SAP S/4HANA Frontend</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA (SAP HANA DATABASE 1.0 and SAP HANA DATABASE 2.0)</td>
<td>The SAP Fiori frontend for SAP S/4HANA can run on SAP HANA, SAP MaxDB, and SAP ASE in a hub deployment, but the database for the SAP S/4HANA backend must be SAP HANA (see table above).</td>
</tr>
<tr>
<td>SAP MaxDB (MAXDB 7.9 64-BIT)</td>
<td>For more information about SAP Fiori for SAP S/4HANA deployment, see Installation of SAP Fiori [page 21] and SAP Note 2590653.</td>
</tr>
<tr>
<td>SAP Adaptive Server Enterprise (SAP ASE) (SAP ASE 16.0 FOR BUS. SUITE)</td>
<td></td>
</tr>
</tbody>
</table>

**i Note**

Databases other than the ones mentioned in the tables above are **not supported** for SAP S/4HANA.
5 Maintenance Planner

We recommend that you use the Maintenance Planner to plan your installation. The tile Plan for SAP S/4HANA provides you with a guided procedure for SAP S/4HANA which also offers information about the selection of SAP Fiori Front-end Server deployment options. You find the tile at http://help.sap.com/maintenanceplanner.

The Maintenance Planner creates a stack XML file with the support package stack information that you then hand over to the Software Provisioning Manager (the installer).

ℹ️ Note

The Maintenance Optimizer (MOPZ) cannot be used with SAP S/4HANA. It has been replaced by the Maintenance Planner.

6 Installation Process

The installation process for SAP S/4HANA and its components is described in the Software Provisioning tool guides referenced in the section Installation Documentation [page 8].
7 Installation Follow-Up Activities

7.1 Applying the Latest Kernel and Support Package Stacks

If you are already on SAP S/4HANA 2021, you can do an update to any higher SAP S/4HANA 2021 feature or support package stack.

- **Recommendation**
  Although it is possible to do the update manually, we recommend that you do this using the Software Update Manager (SUM), as described in the guide Software Update Manager (SUM) 2.0 <latest sp> found at https://support.sap.com/sltoolset.

If you do want to update the kernel manually, proceed as follows:

1. Log on as user `<SAP System ID>adm` to the hosts of the SAP system instances to be updated.
2. Download the latest kernel for your operating system and database platform as described in SAP Note 194667.
3. Back up the kernel directory that is specified by the profile parameter `DIR_CT_RUN`.
4. Extract the SAR files of the kernel support packages of the target support package level to a temporary directory using the SAPCAR tool.
5. Copy or move the extracted programs from the temporary directory to the local kernel directory.
6. Adjust the ownership and permissions of the kernel binaries by entering the following command sequence (Run the `saproot.sh` script that is located in the kernel directory):

```
su - root
cd <kernel_directory>
./saproot.sh <SAP system ID>
exit
```
7.2 Importing Data to SAP S/4HANA

The following sections explain possible ways of migrating data to SAP S/4HANA:

- SAP S/4HANA Migration Cockpit [page 17]
- SAP Data Services [page 20]

7.2.1 SAP S/4HANA Migration Cockpit

For the migration of legacy data to SAP S/4HANA, SAP provides the SAP S/4HANA migration cockpit. It helps you to transfer your master data and business data from SAP systems and non-SAP systems to SAP S/4HANA. The migration cockpit is available as part of SAP S/4HANA and is included in the SAP S/4HANA license.

Using SAP S/4HANA Migration Cockpit

For an overview of the SAP Notes relevant for the SAP S/4HANA migration cockpit, see SAP Note 2780378.

Use the note analyzer report for the scenario SAP S/4HANA Migration Cockpit (MC) available in SAP Note 3016862 to check whether all the necessary SAP Notes for SAP S/4HANA migration cockpit are installed.

SAP Fiori must be set up as prerequisite for the data migration approaches. For more information about the SAP Fiori app Migrate Your Data, see:

- SAP Fiori Apps Reference Library and search for the SAP Fiori app Migrate Your Data
- SAP Note 3039598

As of SAP S/4HANA 2020, there are two migration approaches for transferring data to SAP S/4HANA using the SAP Fiori app Migrate Your Data:

1. Migrate data using staging tables

   The SAP S/4HANA migration cockpit creates staging tables for the migration objects that are relevant for your project and migrates data from these staging tables to the target SAP S/4HANA system. Microsoft Excel XML template files are provided for each migration object. You can use these template files to fill the staging tables with data. Alternatively, you can fill the staging tables using your preferred tools (for example SAP Data Services). For more information about this approach, see SAP Notes 2537549 and 2733253.

   **Note**
   When creating a migration project, you specify a location for the staging tables. If you use the option Local SAP S/4HANA Database Schema, the SAP S/4HANA migration cockpit will generate the staging tables in the local database schema of the SAP S/4HANA system.

   If you use the option Remote SAP HANA Database Schema, you specify the relevant connection to a remote SAP HANA system and the SAP S/4HANA migration cockpit will generate the staging tables there. Prerequisite is a secondary database connection (via transaction DBCO) that has to be listed (manually add it to table DMC_C_WL_DBCO_OP in the SAP S/4HANA system).
For more information about the local SAP S/4HANA and remote SAP HANA database schema, see SAP Note 2733253.

For performance tips and tricks and how to modify data transfer jobs, see SAP KBAs 3065607 and 3066336.

If you are using the SAP S/4HANA technical job repository in your SAP S/4HANA system, the migration cockpit will use it as well. Otherwise, the technical job repository is not used.

2. **Migrate data directly from an SAP system**

This migration approach allows you to directly transfer data from a SAP source system to SAP S/4HANA. You can connect to the source system by using an RFC connection, choose the relevant migration objects, and then select data from the source system based on specific criteria. For more information about this approach, see SAP Notes 2747566 and 2743793.

This migration approach is available for the following migration scenarios:

- SAP ERP to SAP S/4HANA
- SAP Apparel and Footwear (SAP AFS) to SAP S/4HANA for fashion and vertical business
- SAP Extended Warehouse Management (SAP EWM) to decentralized EWM based on SAP S/4HANA
- SAP Customer Relationship Management (SAP CRM) to SAP S/4HANA for Customer Management.
- SAP Supply Chain Management Service Parts Planning (SAP SCM APO SPP) to SAP S/4HANA
- Extended Service Parts Planning (eSPP).

For information about the lowest supported releases for these migration scenarios, see https://help.sap.com/S4_OP_DM Migrate Your Data - Migration Cockpit Migrate Data Directly from SAP System.

**i Note**

Note that the SAP S/4HANA migration cockpit does not support the migration of data from one SAP S/4HANA system to another SAP S/4HANA system. SAP S/4HANA Finance systems (previously known as SAP Simple Finance) are classified as SAP S/4HANA systems.

**i Note**

- The add-on DMIS must be installed in the source system. See SAP Note 2747566 for details.
- An RFC connection between the SAP S/4HANA system and the SAP source system must be available.
  
  The RFC user in the SAP ERP source system must have the role `SAP_DMIS_MC_DT_REMOTE`. For security reasons, we recommend that this RFC user is a user of type Communication. Note that it is not possible to use RFC connections that use trusted systems.
  
  The program `CNV_PE_MC_LOAD_OBJECTS` must have been run in the target SAP S/4HANA system. This program loads the migration objects delivered by SAP from client 000 to the client you are working in. Note that if you update your SAP S/4HANA system to a new release, or install a new feature or support package, you need to run the program again. For more information, see SAP Note 2870546.
  
  The program `CNV_PE_MC_LOAD_OBJECTS` has to be run in the target SAP S/4HANA system. For more information, see SAP Note 2870546.
  
  To check whether your system has an SAP S/4HANA Finance installation go to SAP GUI System Status SAP System data Product version details Installed software component versions where you can see if an SAP S/4HANA Finance product version is installed.
Integration of Custom Data

In addition, the SAP S/4HANA migration cockpit allows you to integrate your custom data into the migration using the migration object modeler. For example, you can adjust the predefined standard migration objects by adding fields to them. You can also create your own custom-specific migration objects or SAP standard objects that have not yet been included in the scope of the migration cockpit.

The functions and features offered by the SAP S/4HANA migration object modeler depend on the migration approach of your SAP S/4HANA migration cockpit project. Detailed documentation for the SAP S/4HANA migration object modeler can be accessed directly from transaction LTMOM.

Migration Objects

For a complete list of migration objects, see https://help.sap.com/S4_OP_MO.

Required Roles

To access the SAP S/4HANA migration cockpit, use the SAP Fiori app Migrate Your Data. You need the business role SAP_BR_CONFIG_EXPERT_DATA_MIG for the front-end server.

To transfer data using the SAP S/4HANA migration cockpit, a user with the role SAP_CA_DMC_MC_USER is required in the SAP S/4HANA system.

To use the migration object modeler (transaction LTMOM), assign the role SAP_CA_DMC_MC_DEVELOPER to the respective user. Before using the modeler, you first need to create a migration project.

Technical Job Repository Information

The technical job repository (SJOBREPO) is active for the dispatcher job of the SAP S/4HANA migration cockpit. This framework uses a technical user, typically SAP_SYSTEM, DDIC or another user specified in the settings.

For the approach migrate data using staging tables, the jobs (for example for simulation or migration) are scheduled with user DDIC. However, the migration steps in the job run with the user who started the activity.

For general information about the technical job framework, see SAP Note 2190119.

Usually, the framework expects either the user SAP_SYSTEM or DDIC. It is, however, also possible to store a different user, see SAP Note 2731999.
The / LTB / JOB_DISPATCHER can work with or without a technical job framework. This means that if the technical job does not exist or is inactive or if the technical job framework does not exist, the jobs are scheduled in the usual way.

The migration approach transfer data directly from SAP System also uses the technical job framework. For this approach, the jobs are started by technical users (for example, SAP_SYSTEM or DDIC). The steps in the jobs are started by the dialog user.

Additional Information

For more information about the SAP S/4HANA migration cockpit, see:

- SAP Note 2481235 - SAP S/4HANA Migration Cockpit (on premise) - restrictions and extensibility of pre-delivered migration objects

7.2.2 SAP Data Services

SAP provides SAP Data Services with Rapid Data Migration content to assist you with importing your data into your SAP S/4HANA system after installation.

For additional information, see:

- SAP Notes 2239701 and 2287723
- SAP Data Services at the SAP Help Portal http://help.sap.com/bods
- SAP Best Practice content for data migration: http://rapid.sap.com/bp/RDM_S4H_OP

7.3 System Configuration for SAP S/4HANA

After you have installed SAP S/4HANA, you have a number of options how to proceed with the system configuration:

1. You follow SAP Activate and SAP Best Practices to guide you through your system configuration.

   **Note**

   We strongly recommend that you use SAP Activate and SAP Best Practices as this will simplify both the initial implementation process and future updates of your software.

   SAP Activate is the innovation adoption framework that helps you to implement your SAP S/4HANA system. It provides ready-to-run business and technology processes and guided configurations. For ordering information see SAP Note 2041140 (for partners and customers). For additional information about SAP Activate and SAP Best Practices, see the SAP Help Portal at https://help.sap.com/s4hana_op_2021 | Implement | SAP Best Practices |
2. You use SAP Activate and SAP Best Practices as templates for your system configuration and make changes using the Implementation Guide (IMG). This allows you to adapt the SAP-delivered configuration settings to your specific requirements.

3. You use only the Implementation Guide (IMG) to configure your system.

**i Note**


### 7.4 Installation of SAP Fiori

There are two possible deployment options for SAP Fiori for SAP S/4HANA, the embedded or the hub deployment option.

**Embedded Deployment**

Components for embedded deployment for SAP S/4HANA 2021:

- Optional UI components (HR, Travel, MDG)
- SAP Fiori for SAP S/4HANA 2021
- SAP Fiori front-end server 2021 for SAP S/4HANA
- UIBAS001 700
After the installation of SAP S/4HANA 2021, the other components of the embedded deployment option may need to be upgraded to the required version.

**Hub Deployment**

You can co-deploy an existing SAP Business Suite hub with the SAP Fiori for SAP S/4HANA 2021 deployment. Existing apps continue to run against the SAP Business Suite back-end systems while the newly installed applications of SAP Fiori for SAP S/4HANA 2021 need to be configured to run against the SAP S/4HANA 2021 system. As a prerequisite, you have to migrate the database of the existing SAP Business Suite hub (supported databases are SAP HANA, SAP MaxDB, or SAP ASE) and upgrade the system to the minimum required versions.

Components for hub deployment for SAP S/4HANA 2021:

- **Frontend:**
  - Optional UI components (HR, Travel, MDG)
  - SAP Fiori for SAP S/4HANA 2021
  - SAP Fiori front-end server 2021 for SAP S/4HANA
  - UIBAS001 700
  - SAPUI5 1.90
  - SAP_UI 7.56
  - SAP Gateway 7.52
  - SAP NetWeaver 7.52 SP08 (minimum version)

- **Backend:**
  - SAP S/4HANA 2021
  - S4CORE 106
  - SAP Gateway 7.56
  - ABAP Platform 2021 (part of SAP S/4HANA 2021)

For more information, see:

- SAP Notes 2590653 and 2790996

**7.5 User Assistance Settings**

The following sections describe how to enable context-sensitive user assistance and back-end help links for SAP S/4HANA.
Once you have correctly configured the help settings and SAP Web Dispatcher, the context-sensitive user assistance will be available on the SAP Fiori launchpad and back-end help links to the product assistance will work.

To test whether you have correctly configured the context-sensitive user assistance, choose the question mark icon on the SAP Fiori launchpad homepage.

If content is displayed, everything is correctly configured and all available content, such as static help or guided tours, will be visible in all apps.

### 7.5.1 Enable Context-Sensitive User Assistance and Back-End Help Links

*Note*

You can run this task as part of the automatic tasklist *SAP Fiori - Initial Setup for Fiori Applications S/4* (*SAP_FIORI_FOUNDATION_S4*). This is only possible if you have implemented SAP Note [2712785](https://launchpad.support.sap.com/#/notes/2712785).

To make context-sensitive user assistance available in the SAP Fiori launchpad and to enable back-end help links, proceed as follows:

1. Run transaction `HELP_CONFIG` (*Configure Help Settings*).
2. Select *Embedded Deployment* or *Hub Deployment*.
   
   Depending on what you select, the sections *General Settings*, *Front-End Settings*, and *Back-End Settings* are displayed with prefilled fields.

   **General Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>SAP_S4HANA_ON-PREMISE</td>
</tr>
<tr>
<td>Version</td>
<td>2021.latest</td>
</tr>
<tr>
<td>RFC Destination</td>
<td>&lt;blank&gt;</td>
</tr>
</tbody>
</table>

*Note*

This field only appears if you select *Hub Deployment*

If you do, you have to enter a suitable RFC connection into the field to establish a connection to the relevant frontend system.
Front-End Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learning App Workspace</td>
<td>s4</td>
</tr>
<tr>
<td>SAP Community URL</td>
<td><a href="https://community.sap.com/">https://community.sap.com/</a></td>
</tr>
<tr>
<td>Show Short Description</td>
<td>false</td>
</tr>
</tbody>
</table>

Back-End Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>EN,DE</td>
</tr>
<tr>
<td>Entry Topic ID</td>
<td>2C0E7C571FBEB576E10000000A4450E5</td>
</tr>
<tr>
<td>Path</td>
<td>SAP_S4HANA_ON-PREMISE/2021.latest</td>
</tr>
</tbody>
</table>

i Note

You cannot manually change the value of this field, as it is generated based on the product and version values.

3. Modify the values if required.
   We recommend filling the Version field with the "latest" version for the relevant release (for example 2021.latest).

   i Note

   If you wish to link to user assistance for a specific release (for example to the version for SAP S/4HANA 2021 FPS00), please see SAP Note 3090792. We recommend, however, to link to the latest version as this ensures that you receive the most up-to-date documentation.

4. Execute the report.

Result

Depending on your deployment scenario, the settings in transactions /UI2/FLP_CUS_CONF and/or SR13 are configured with the values maintained in the report.
**Technical Details**

The following settings are maintained by default in transaction `/UI2/FLP_CUS_CONF` when executing the report:

<table>
<thead>
<tr>
<th>FLP Configuration</th>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABLE_HELP</td>
<td>true</td>
<td>This setting is a prerequisite for the context-sensitive help to work with the SAP Fiori launchpad.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WEB_ASSISTANT_HELP_PLUGIN</th>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUTTON_LOCATION</td>
<td>head</td>
<td>The help button is displayed in the SAP Fiori launchpad header.</td>
</tr>
<tr>
<td>NO_HELP_MODE</td>
<td>carousel</td>
<td>The help button and panel are always displayed, even if no content is available.</td>
</tr>
<tr>
<td>USE_GLOBAL_HELP</td>
<td>true</td>
<td>In SAP GUI for HTML and WebDynpro apps, instructions about how to access help content are displayed.</td>
</tr>
</tbody>
</table>

In transaction SR13, entries are created based on the defined server, path, and languages. For each language, entries for the areas `XML_DOCU` and `IWBHELP` and the most common platforms (such as `ITS` and `WN32`) are created.

**Additional In-App Help Configuration Settings**

In addition to executing `HELP_CONFIG`, you have to maintain further values to enable the in-app help.

We recommend making these settings as described below, but if you are already using SAP Web Dispatcher, you can also make the settings there, as described in Configure the SAP Web Dispatcher [page 26].

1. Run transaction `/UI2/FLP_CUS_CONF`.
2. Select `Launchpad Plug-Ins`.
3. For the plugin `WEB_ASSISTANT_HELP_PLUGIN`, enter the following value into the URL field: https://xray.hana.ondemand.com/xRayControls/resources/sap/dfa/help/utils/adapters/fiori
4. Select `Configuration`.
5. Add an entry with the launchpad property ID `PARAMETERS` and the value `resourceUrl=https://xray.hana.ondemand.com/xRayControls/resources/sap/dfa/help`.
6. Save your changes.
Result

The question mark for in-app help will be displayed in the relevant front-end system.

7.5.2 Configure the SAP Web Dispatcher

i Note

Instead of configuring the SAP Web Dispatcher, you can maintain the URLs required for the context-sensitive user assistance in transaction /UI2/FLP_CUS_CONF as described in SAP Note 3022494.[1]

If this does not work, please configure the SAP Web Dispatcher as described below.

Use

If you want to make context-sensitive user assistance available in the SAP Fiori launchpad, you must configure SAP Web Dispatcher.

Prerequisites

You have installed SAP Web Dispatcher 7.5 as the reverse proxy. For more information, go to https://help.sap.com/s4hana_op_2021, enter Operating SAP Web Dispatcher into the search bar, press Enter, open the search result with that title and navigate to the section Installing SAP Web Dispatcher.

Activities

1. Adjust the SAP Web Dispatcher profile file.

In the sapwebdisp_pf.txt file, add the following parameters:

- For the User Assistance Content Platform
  
  wdisp/system_<number> = SID=<SID1>, EXTSRV=https://cp.hana.ondemand.com:443, SRCURL=/sap/dfa/help/, SRCSRV=***, PROXY=<your proxy>:<your proxy port>, STANDARD_COOKIE_FILTER=OFF

- For the script server in your production system
  
  wdisp/system_<number> = SID=<SID2>, EXTSRV=https://xray.hana.ondemand.com:443, SRCURL=/resources/sap/dfa/help/, SRCSRV=***, PROXY=<your proxy>:<your proxy port>, STANDARD_COOKIE_FILTER=OFF
2. Activate the usage of the modification handler:
   
icm/HTTP/mod_0 = PREFIX=/, FILE=$(DIR_PROFILE)/redirect.txt
   
   For more information, go to https://help.sap.com/s4hana_op_2021, enter SAP Web Dispatcher Parameter References into the search bar, press Enter, open the search result with that title and navigate to the section icm/HTTP/mod_<xx>.

3. Adjust the SAP Web Dispatcher redirect file.
   
   In the redirect.txt file, add the following parameters:

   ```
   # User Assistance Content Platform - rewrite rule
   if %{SID} = <SID1>
   begin
   SetHeader HOST cp.hana.ondemand.com:443
   RegRewriteRawUrl  ^/sap/dfa/help/(.*) /dps/$1
   end

   # Script Server - rewrite rule
   if %{SID} = <SID2>
   begin
   SetHeader HOST xray.hana.ondemand.com:443
   RegRewriteRawUrl  ^/resources/sap/dfa/help/(.*) /xRayControls/resources/sap/dfa/help/$1
   end
   ```

   **Note**
   
   Make sure that the SIDs in the redirect.txt file are the same as in the sapwebdisp_cf.txt file.

4. You can check if the content platform is working properly through the proxy connection by accessing:
   
   https://<your server>:<your port>/sap/dfa/help/odata.svc/?$format=json
   
   **Example**
   
   If the content platform is connected correctly, you can see on your screen the following output, for example:

   ```
   {"d":{"EntitySets":
   ["Transport","DeliverableForReplication","Tile","Project","Deliverable","TransportHistory","TourIssue","ReplicationTourIssue","Hotspot","Product","Context"]}}
   ```

5. You can check if the help script server is working properly through the proxy connection by accessing:
   
   https://<your server>:<your port>/resources/sap/dfa/help/utils/adapters/fiori/Component.js
   
   **Example**
   
   If the help script server is connected correctly, you can see on your screen the following output, for example:

   ```
   {
   ```
You can access SAP Fiori launchpad with context-sensitive user assistance.

### 7.6 Installation of a Digital Assistant

A digital assistant enables a humanized user experience for your SAP applications and is an optional addition to your SAP S/4HANA system. It allows you to accomplish tasks without having to navigate away from the context of your screen, for example.

A separate purchase may be required to use the digital assistant capabilities for SAP S/4HANA.

For more information about the digital assistant capabilities available for use with SAP S/4HANA, see:


### 7.7 Installation of the PI Adapters for Elster and Swift

The Advanced Adapter Engine Extended (AEX) is required for the installation of the Process Integration Adapters for Elster and Swift. AEX is part of SAP S/4HANA as described in the section Product Information [page 11]. For more information about Elster and Swift, see also SAP Notes [1802839](https://launchpad.support.sap.com/#/notes/1802839) and [1064419](https://launchpad.support.sap.com/#/notes/1064419).

You have the following two options how to install the Elster/Swift adapters:

#### 1 Installation from DVD

With this option, you copy the archives from the DVD location \S4HANA10\JAVA\DATA_UNITS\S4_JAVA to the directory /usr/sap/trans/EPS/ and use the Software Update Manager (SUM) to deploy the files using the option Manually prepared directory.
For more information how to use the SUM tool, see SUM guides at https://support.sap.com/sitoolset

System Maintenance > System Maintenance Scenarios > Software Update/Upgrade using SUM > Guides for SUM 2.0 <latest SP>

Select the guide according to your operating systems and database.

2 Installation with Maintenance Planner

With this option, you use Maintenance Planner to generate a stack XML file with the Elster and Swift support package stack information that you then hand over to the Software Update Manager (SUM) tool.


7.8 Creating RFC Destinations for liveCache Applications

You use this procedure to use liveCache across clients, for example, to initialize liveCache correctly.

1. Create a user with the following authorizations in all production clients:
   - Cross-application AAAB authorization objects
     Authorization object: S_TCODE Value: SE38
     Authorization object: S_RFC Activity: 16
     Name of RFC object to be protected: /SAPAPO/DM_LC_SYNC, SYST
     Type of RFC object to be protected: FUGR
   - Basis development environment BC_C
     Authorization object: S_DEVELOP Value: 03, 16
     Authorization object: S_PROGRAM
     User action ABAP/4 program: *
     Authorization gr:ABAP/4 program: (no input necessary)
   - Basis administration BC_A
     Authorization object: 'S_BTCH_JOB'
     User action: 'RELE'

   **Note**
   Ensure that the user no longer has the initial password in any of the clients.

2. In each client, create a RFC destination by performing the following substeps:
   1. Start transaction SM59.
   2. Choose Create.
   3. Add a **CLNT** string and the client number (for example, "678") to your system ID (for example, "XYZ") to determine the connection name.

   **Note**
   This constitutes the connection name (for example, "XYZCLNT678"). You must adhere to this naming convention as ABAP does not recognize other names, for example, "XYZMAND678", and causes errors. If there is already a connection with the same destination but a different name, you must still create the connection as described."
4. Enter the connection name in RFC destination.
5. As a connection type, choose “3” (= SAP S/4HANA backend system destination or connection to the ABAP system).
6. Enter a description for the destination.
7. In the Logon section, enter the user credentials of the user created in this client in step 1.

   **Note**
   Ensure that the password is no longer initial, and do not select Current User.

8. Save the changes.

### Verifying the Above Steps

To check that you have carried out all the steps correctly, choose Remote Login.

The system should display an SAP S/4HANA backend system window, but not an SAP S/4HANA backend system logon screen. If the system displays an SAP S/4HANA backend system logon screen, check if all steps above were performed correctly, you should check whether or not the user is actually available in this client (in particular). This test is not possible with an RFC destination with a CPIC user.

**Note**
You create the same user in each client only once. You must, however, ensure that the clients of the destination and user match. The user may also be a CPIC user. The authorization “Authorization object: S_TCODE Value: SE38” and similar should be assigned here also. You should also check if you can implement SAP Note 536291

### 7.9 Follow-Up Activities for Advanced Variant Configuration

#### AVC Post-Installation Steps

**Configuring SAP Fiori alias**

The SAP Fiori alias configuration is necessary for the embedded SAP Fiori Launchpad in SAP GUI or WebGUI to run the AVC SAP Fiori Application. It must be determined which ABAP system acts as a provider for the SAP Fiori Launchpad. The reason for this configuration is found in the different deployment variants. In the following steps it is relevant which deployment variant out of the four specified has been chosen:

- Co-Deployment with Web Dispatcher
- Co-Deployment without Web Dispatcher
- Hub-Deployment with Web Dispatcher
- Hub-Deployment without Web Dispatcher

1. Run transaction stc01 in the backend or S/4 Co-Deployment system
2. Create a tasklist run for SAP_SAP2GATEWAY_TRUSTED_CONFIG

3. Maintain parameters for step 2 – Create ABAP / HTTP(S) Connections for SAP System (SM59) as described in the following table:

<table>
<thead>
<tr>
<th></th>
<th>Co-Deployment with Web Dispatcher</th>
<th>Co-Deployment without Web Dispatcher</th>
<th>Hub-Deployment with Web Dispatcher</th>
<th>Hub-Deployment without Web Dispatcher</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ABAP System</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System ID</td>
<td>S4 SID</td>
<td></td>
<td>FRONTEND SID</td>
<td></td>
</tr>
<tr>
<td>Client</td>
<td>S4 CLIENT</td>
<td></td>
<td>FRONTEND CLIENT</td>
<td></td>
</tr>
<tr>
<td>Create HTTPS connection</td>
<td></td>
<td></td>
<td>TRUE</td>
<td></td>
</tr>
<tr>
<td>Create HTTP connection</td>
<td></td>
<td></td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td><strong>ABAP Connection</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Balancing Mode</td>
<td>FALSE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Target host</td>
<td>S4 HOST</td>
<td></td>
<td>FRONTEND HOST</td>
<td></td>
</tr>
<tr>
<td>Service</td>
<td>S4 INST NR</td>
<td></td>
<td>FRONTEND INST NR</td>
<td></td>
</tr>
<tr>
<td><strong>HTTPS Connection to ABAP system</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Host</td>
<td>WEB DISP HOST</td>
<td>S4 HOST</td>
<td>WEB DISP HOST</td>
<td>FRONTEND HOST</td>
</tr>
<tr>
<td>Port</td>
<td>WEB DISP SSL PORT</td>
<td>S4 SSL PORT</td>
<td>WEB DISP SSL PORT</td>
<td>FRONTEND SSL PORT</td>
</tr>
<tr>
<td>Path Prefix</td>
<td>/sap/bc/ui2/flp</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**i Note**

For obtaining host and port, the transaction smicm (List Services) can be used. The instance Number can be read from the profile – transaction rz10.

**Remove RFC destination (only Co-Deployment)**

1. Start transaction SM59 on the S/4 Co-Deployment system
2. Open node ABAP Connections (Type 3)
3. Delete the created destination <S4_SID>CLNT<S4_CLIENT>_RFC (this is necessary as a missing RFC destination for the specified Fiori alias mapping is the indicator for the Co-Deployment variant and prevents the system from sending origin information, which in Co-Deployment is not allowed by the gateway)
Trusted RFC connection (only Hub-Deployment)

1. Start transaction stc01 in the backend system
2. Create a tasklist run for SAP_ABAP2ABAP_TRUST_CLIENT_CFG
3. Maintain parameters for step 2 — Create / Select trusted ABAP RFC Destination to SAP System (SM59)
4. Select the RFC destination created before <FRONTEND_SID>CLNT<FRONTEND_CLIENT>_RFC
5. Perform the manual steps for the authorization check as described

HTTP Whitelist Maintenance on Frontend (only Hub-Deployment)

The HTTP Whitelist can be maintained using transaction se16 for editing table HTTP_WHITELIST or transaction uconcockpit. Be aware that when switching to uconcockpit, the old table maintenance can no longer be used. The following section describes the procedure using uconcockpit.

1. Start transaction uconcockpit
2. Select HTTP Whitelist Scenario from the scenario dropdown
3. Go to menu HTTP Whitelist -> Setup
4. Activate Clickjacking Protection by selecting the option Activate Clickjacking Protection (Context Type 02) for all clients (recommended)
5. Enter the detail screen for context type 02 (Clickjacking Frame Protection) by double-clicking on it
6. Enter a new entry on the right side of the screen with the following data:
   - Schema rule: * or HTTPS
   - Host rule: Backend host
   - Port rule: * or SSL Port
   - Path rule: *

Activation of OData Services

1. Start transaction stc01 in the frontend or S/4 Co-Deployment system
2. Create a tasklist run for SAP_GATEWAY_ACTIVATE_ODATA_SERV
3. Maintain parameters for step 2 — Define OData Services for Activation
4. Enter the services: LO_VCHCLF and LO_VCHCLF_INTEGRATION_LEGACY_SRV
5. Maintain parameters for step 3 — Select Processing Mode / System Alias for Activation
6. Choose the settings depending on the deployment variant from the following table:

<table>
<thead>
<tr>
<th></th>
<th>Co-Deployment with Web Dispatcher</th>
<th>Co-Deployment without Web Dispatcher</th>
<th>Hub-Deployment with Web Dispatcher</th>
<th>Hub-Deployment without Web Dispatcher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processing Mode</td>
<td>Co-deployed-only</td>
<td>Routing-Based</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Alias</td>
<td>n.a.</td>
<td>Select Alias of Frontend -&gt; Backend connection</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Execute the Report VCH_MASS_MAINTENANCE

You use this report for the initial preparation of your variant configuration data for SAP S/4HANA Advanced Variant Configuration. For information about how to use the report, see the system documentation in transaction SE38 or SE80, click on the Goto menu, and select Documentation.

Post-Installation Steps for VCH AFL

An Application Function Library (AFL) extends the SAP HANA Database with functions required for business applications - specifically, the VCH AFL (Variant Configuration on SAP HANA) extends the SAP HANA Database with functions to run SAP S/4HANA Advanced Variant Configuration. After you have installed VCH AFL (SAP VCH AFL 2021.00), you need to do some post-installation steps for the VCH AFL described in SAP Note 2987015.

i Note
For information about the installation of this component, see Installation Documentation [page 8]: SAP HANA Server Installation and Update Guide.

7.10 Follow-Up Activities for Predictive Analytics integrator

To enable the use of Predictive Analytics integrator with SAP S/4HANA, perform the following steps:

<table>
<thead>
<tr>
<th>Product</th>
<th>Supporting Documentation</th>
<th>Further Information</th>
</tr>
</thead>
</table>
For more detailed information about the exact APL version required for Predictive Analytics integrator, please refer to SAP Note 2631182. |

Application Function Library (AFL), which includes SAP HANA Predictive Analysis Library

For more information, go to the chapter called Prerequisites in the SAP HANA Predictive Analysis Library (PAL) guide on the SAP Help Portal at https://help.sap.com

Choose the option to install PAL. The revision number of the AFL must match the revision number of SAP HANA. Ensure that the correct AFL role is assigned. Assign one of the following roles to the SAP HANA database user or ABAP technical user:

- AFL__SYS_AFL_AFLPAL_EXECUTE
<table>
<thead>
<tr>
<th>Product</th>
<th>Supporting Documentation</th>
<th>Further Information</th>
</tr>
</thead>
</table>
| Predictive Analytics integrator (UMML4HANA 1) Delivery Unit | For more information, go to https://help.sap.com/viewer/p/SAP_HANA_PLATFORM  
  - Development ➔ SAP HANA Developer Guide (How to develop applications for SAP HANA Extended Application Services classic model using the SAP HANA studio, including modeling data and analytic views, and building application logic) ➔ SAP HANA Application Lifecycle Management ➔ Maintaining Delivery Units ➔ Import a Delivery Unit | • AFL__SYS_AFL__AFLPAL__EXECUTE_WITH_GRANT_OPTION  
  - Note  
    1. We suggest this path when searching for the correct Delivery Unit: Support Packages and Patches ➔ By Alphabetical Index ➔ SAP S/4HANA ➔ UMML4HANA 1.  
    2. For more detailed information about the exact Predictive Analytics integrator (UMML4HANA 1) Delivery Unit version required, please refer to SAP Note 2631182. |
| SAP HANA database user or ABAP technical user roles | Assign the sap.hana.pai::ExecutePAI role to the SAP HANA database user or ABAP technical user, in order for them to access functionality such as training and executing models. | N/A                                                                                                     |
| Configuration                                | For information about ABAP Technical Jobs, you can refer to the chapter called ABAP Technical Jobs. For information on setting up the OData service and bgRFC Queue, you can refer to the chapters called Setting up the OData Service and Setting up the bgRFC Queue. For information on setting up the required authorization, go to the the chapters called Configuring Business Roles for the Backend and Configuring Business Roles for the Frontend. | • ABAP Technical Jobs [page 34]  
  • Setting up the OData Service [page 35]  
  • Setting up the bgRFC Queue [page 39]  
  • Configuring Business Roles for the Backend [page 40]  
  • Configuring Business Roles for the Frontend [page 43] |

### 7.10.1 ABAP Technical Jobs

PAi uses ABAP technical jobs to perform model version training.

To run technical jobs in SAP S/4HANA, one of the users SAP_SYSTEM or DDIC with SAP_ALL authorization must be available in the ADMIN (="000") and BUSINESS clients.

This user is used by default to execute technical jobs.
Viewing and Monitoring ABAP Technical Jobs

To view ABAP technical jobs, use transaction SJOBREPO. To monitor the execution of ABAP technical jobs, use transaction SM37. Enter the job name into the ABAP program name field.

<table>
<thead>
<tr>
<th>Job Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_PAI_SCHEDULER</td>
<td>This job runs in the Administration Client system, and manages the execution concurrency control for PAi. The job is timed based, and runs frequently to manage the PAi workload on the system.</td>
</tr>
<tr>
<td>SAP_PAI_PROCESSOR</td>
<td>This job runs in Business Client, and performs model version training. It’s triggered when EVENT is raised by the scheduler as needed.</td>
</tr>
</tbody>
</table>

PAi Training Concurrency Limit

To limit the workload on the system, SAP S/4HANA have restricted to 2, the default number of PAi model version trainings that may run concurrently. This restriction is achieved with the jobs SAP_PAI_SCHEDULER and SAP_PAI_PROCESSOR, and a queuing process.

This limit can be changed by using transaction SM30 for maintenance for the table RSANAUMMTSKSCONF.

<table>
<thead>
<tr>
<th>Task Type</th>
<th>Train</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Level</td>
<td></td>
</tr>
<tr>
<td>● S = System level restriction</td>
<td></td>
</tr>
<tr>
<td>● C = Client level restriction</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Limit</th>
<th>Number of concurrent PAi model version trainings allowed</th>
</tr>
</thead>
</table>

7.10.2 Setting up the OData Service

Setting up the OData service for Predictive Models and Predictive Scenarios apps.

The Open Data Protocol (OData) is a standardized protocol for exposing and accessing information from various sources. OData is based on core protocols, including HTTP, AtomPub (Atom Publishing Protocol), XML, and JSON (Java Script Object Notation).

OData provides a standard API on service data and metadata presentation and data operations. Use OData version 2.0.

For access to Predictive Models and Predictive Scenarios apps, you need to register the OData Service as the backend server. The steps for doing this will be different depending on how the servers are configured. The main configuration tasks are as follows:

- Configure the OData service backend server.
- Configure the OData service frontend server. (Only required where the frontend and backend servers are on different machines)
7.10.2.1 Setting up OData - Configuring the Backend Server for Predictive Models App

How to set up the backend server for the OData service for the Predictive Models app.

Context

For the Predictive Models app you need to register the OData service as the backend server. To do so, perform the following steps:

Procedure

1. Open SAP-Logon.
2. Enter the transaction /IWFND/MAINT_SERVICE in the top left side of the user interface.
3. Select Add Service.
4. Select the System Alias field.
5. Select the icon to open the SAP System Alias window.
6. In the SAP System Alias window, select Local.
7. Select the OK button to confirm the selection.
8. In the External Service Name field, search for ANA_PAI_REPOSITORY_SRV
9. Select Enter to search.
   The result is shown in the Select Backend Services panel in the column Technical Service Name.
10. Select the service name in the listing.
    The Add Service window opens.
11. In Add Service window, for Package Assignment, select Local Object, or assign a suitable package as required.
12. Select the icon to accept.
13. The Information window opens, confirming that the service was created.

Next Steps

If the OData backend and frontend servers are installed on different machines, then you will need to perform additional configuration on the OData frontend server.
7.10.2.2 Setting up OData - Configuring the Backend Server for Predictive Scenarios App

How to set up the backend server for the OData service for the Predictive Scenarios app.

Context

For the Predictive Scenarios app, you need to register the OData Service as the backend server. The ANA_PAI_PF_SRV service is used in conjunction with SAP Predictive Factory or SAP Analytics Cloud Smart Predict to create the draft predictive scenarios. The ANA_PAI_PS_SRV service is used by the Fiori app to display or update draft predictive scenarios, and display published ones. Perform the following steps for both:

Procedure

1. Open SAP-Logon.
2. Enter the transaction /IWFND/MAINT_SERVICE in the top left side of the user interface.
3. Select Add Service.
4. Select the System Alias field.
5. Select the icon to open the SAP System Alias window.
6. In the SAP System Alias window, select Local.
7. Select the OK button to confirm the selection.
8. In the External Service Name field, search for ANA_PAI_PS_SRV and ANA_PAI_PF_SRV.
9. Select Enter to search.
   - The results are shown in the Select Backend Services panel in the column Technical Service Name.
10. Select the service names in the listing.
    - The Add Service window opens.
11. In Add Service window, for Package Assignment, select Local Object, or assign a suitable package as required.
12. Select the icon to accept.
13. The Information window opens, confirming that the service was created.

Next Steps

If the OData backend and frontend servers are installed on different machines then you will need to perform additional configuration on the OData frontend server.
7.10.2.3  Setting up OData - Configuring the Frontend Server

How to set up the frontend service for the OData service for Predictive Models and Predictive Scenarios apps.

Context

SAP S/4HANA provides an interface through which you can also integrate predictive use cases from another system, currently SAP Predictive Factory or SAP Analytics Cloud Smart Predict. In scenarios, where the backend and frontend servers are on different machines, you need to perform the following steps on the frontend server:

Procedure

1. Open SAP-Logon.
2. On the upper left enter transaction /IWFND/MAINT_SERVICE.
3. Select Add Service.
4. Click the field SAP System Alias. Click the search button. The SAP System Alias window opens.
5. Select the appropriate server name where your service is running. Confirm this selection by double-clicking. Note: The frontend server communicates with the backend server using RFC (Remote Function Call).
6. Search for a backend service (the PAi backend service that you previously created) to add by entering part of the service name, enclosed in * characters. Press enter, and the search result is listed in the Select Backend Services panel in the column Technical Service Name. Click on the service name in the listing. The Add Service window opens.
7. In the Add Service window, in the Package Assignment field, select Local Object for Package Assignment or specify suitable package as required. Click accept.
8. An Information popup window should appear, confirming that the service was created. Click the accept button to confirm that the process has been completed.
7.10.3 Setting up the bgRFC Queue

How to configure background processing with the bgRFC Queue.

Context

You need to configure the settings for background processing with the bgRFC Queue. Do the following:

Procedure

1. Log on to the SAP backend system using the SAP GUI.
2. Access the activity using the transaction code: SBGRFCCONF.
3. On the bgRFC Configuration screen, choose the Define Supervisor Dest tab page.
4. On the Define Supervisor Dest tab page, choose Create.
5. In the Create RFC Destination for Supervisor dialog box, maintain the following data:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Name</td>
<td>BGRFC_SUPERVISOR</td>
</tr>
<tr>
<td>Create User</td>
<td>This should be checked.</td>
</tr>
<tr>
<td>User Name</td>
<td>BGRFC_SUPER</td>
</tr>
<tr>
<td>Password</td>
<td>Enter a password.</td>
</tr>
</tbody>
</table>

6. Choose Save.
7. On the bgRFC Configuration screen, choose Save.
8. On the bgRFC Configuration screen, choose the Define Inbound Dest tab page.
10. On the Configure Inbound Destination screen, maintain the following settings:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inb. Dest. Name</td>
<td>PAI_QBGRFC_INBOUND_DEST</td>
</tr>
<tr>
<td>Add Queue Prefix</td>
<td>PAI_</td>
</tr>
</tbody>
</table>

11. In the Add Queue Prefix screen area, choose Add.
12. Choose Save.
15. On the Create Scheduler Settings for Inbound Destination screen, choose the PAI_QBGRFC_INBOUND_DEST destination.

16. Choose Save.

17. Choose Save again.

18. Choose Back.

7.10.4 Configuring Business Roles for the Backend

Configuring business roles for the backend.

Backend roles should be assigned based on the Predictive Models app and Predictive Scenarios app user’s needs. Backend roles should include the necessary PAi authorizations as described in the following chapters: Backend Authorization for Predictive Scenarios and Backend Authorization for Predictive Models.

Related Information

Backend Authorization for Predictive Scenarios [page 40]
Backend Authorization for Predictive Models [page 42]

7.10.4.1 Backend Authorization for Predictive Scenarios

How to perform backend ABAP role configuration for predictive scenarios.

Context

Additional configuration is required for PAi-specific authorizations, which grant roles access to predictive scenarios and predictive models.

You will need to authorize a role to call the PAi OData service (ANA_PAI_PS_SRV) using the OData service authorization object (S_SERVICE).

You also need to add authorizations for the authorization objects RSANAUMPS and S_DEVELOP, which are required for predictive analytics.

Procedure

To add authorizations, follow these steps:
1. In the SAP backend system, access the activity using the transaction code PFCG or on the IMG menu, navigate to Tools > Administration > User Maintenance > Role Administration > Roles.
2. On the Role Maintenance screen, create a new role. Enter the name of your role.
4. Enter a description and save your created role.
5. Select the Menu tab.
6. Select the SAP Fiori Tile Catalog from the Insert Node dropdown menu.
7. Select the Remote Front-End Server radio button and provide the RFC variable or the RFC destination to establish a connection to the front-end server.
8. Enter the catalog SAP_CA_BC_ANA_UMM_PSC.
9. Select Enter to continue.
10. Select Save.
11. Select the Authorizations tab.
12. Select Expert Mode for Profile Generation.
13. Select Read old status and merge with new data and choose OK.
   This step is not always required. If you don’t see Read old status and merge with new data, you can ignore this step.
14. Modify the authorization objects and populate the fields with these values:

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Field</th>
<th>Value in Business Catalog Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSANAUMMPS</td>
<td>ACTVT</td>
<td>Add or Create, Change, Display, Delete (01, 02, 03, 06)</td>
</tr>
<tr>
<td></td>
<td>PRED_SCEN</td>
<td>&lt;PS_NAME&gt;</td>
</tr>
<tr>
<td></td>
<td>PAI_OTYPE</td>
<td>PSCENARIO, MCONTEXT, ENHMODEL, MVERSION</td>
</tr>
<tr>
<td>S_DEVELOP</td>
<td>DEVCLASS</td>
<td>&lt;Package&gt;</td>
</tr>
<tr>
<td></td>
<td>OBJTYPE</td>
<td>PAI1</td>
</tr>
<tr>
<td></td>
<td>OBJNAME</td>
<td>&lt;PS_NAME&gt;</td>
</tr>
<tr>
<td></td>
<td>P_GROUP</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td>Create (01)</td>
</tr>
<tr>
<td>S_DEVELOP</td>
<td>DEVCLASS</td>
<td>&lt;Package&gt;</td>
</tr>
<tr>
<td></td>
<td>OBJTYPE</td>
<td>DDLS</td>
</tr>
<tr>
<td></td>
<td>OBJNAME</td>
<td>&lt;PS_NAME&gt;_TF01</td>
</tr>
<tr>
<td></td>
<td>P_GROUP</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td>Add or Create, Change, Display, Delete, Activate, generate (01, 02, 03, 06, 07)</td>
</tr>
<tr>
<td>S_DEVELOP</td>
<td>DEVCLASS</td>
<td>&lt;Package&gt;</td>
</tr>
<tr>
<td>Authorization Object</td>
<td>Field</td>
<td>Value in Business Catalog Role</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td></td>
<td>OBJTYPE</td>
<td>DDLS</td>
</tr>
<tr>
<td></td>
<td>OBJNAME</td>
<td><code>&lt;PS_NAME&gt;_CDS01</code></td>
</tr>
<tr>
<td></td>
<td>P_GROUP</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td>Add or Create, Change, Display, Delete, Activate, generate (01, 02, 03, 06, 07)</td>
</tr>
<tr>
<td>S_DEVELOP</td>
<td>DEVCLASS</td>
<td><code>&lt;Package&gt;</code></td>
</tr>
<tr>
<td></td>
<td>OBJTYPE</td>
<td>VIEW</td>
</tr>
<tr>
<td></td>
<td>OBJNAME</td>
<td>Z_*</td>
</tr>
<tr>
<td></td>
<td>P_GROUP</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td>Display, Create in DB, Convert to DB (03, 40, 42)</td>
</tr>
</tbody>
</table>

15. On Exit Authorization Maintenance, select Save.
16. Select Generate.

### 7.10.4.2 Backend Authorization for Predictive Models

How to perform backend ABAP role configuration for Predictive Models.

**Context**

Additional configuration is required for PAI-specific authorizations, which grant roles access to predictive scenarios and predictive models.

You will need to authorize a role to call the PAI OData service (ANA_PAI_REPOSITORY_SRV) using the OData service authorization object (S_SERVICE).

You also need to add authorizations for the authorization object RSANAUMMPS, which is required for predictive analytics.

To add authorizations for RSANAUMMPS, do the following:

**Procedure**

1. In the SAP backend system, access the activity using the transaction code PFCG or on the IMG menu, navigate to Tools > Administration > User Maintenance > Role Administration > Roles.
2. On the Role Maintenance screen, create a new role. Enter the name of your role.
3. Choose **Single Role**.
4. Enter a description and save your created role.
5. Select the **Menu** tab.
6. Select the **SAP Fiori Tile Catalog** from the **Insert Node** dropdown menu.
7. Select the **Remote Front-End Server** radio button and provide the RFC variable or the RFC destination to establish a connection to the front-end server.
8. Enter the catalog `SAP_CA_BC_ANA_UMM`.
9. Select **Enter** to continue.
10. Select **Save**.
11. Choose the **Authorizations** tab.
12. Modify the authorization objects and populate the fields with these values:

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Field</th>
<th>Value in Business Catalog Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSANAUMMPS</td>
<td>ACTVT</td>
<td>Read (03)</td>
</tr>
<tr>
<td></td>
<td>PRED_SCEN</td>
<td>Enter the name of the business case. &lt;PAI Predictive Scenario Name&gt;</td>
</tr>
<tr>
<td></td>
<td>PAI_OTYPE</td>
<td>PSCENARIO, MCONTEXT, ENHMODEL</td>
</tr>
<tr>
<td>RSANAUMMPS</td>
<td>ACTVT</td>
<td>Create, Change, Read, and Delete (01,02,03,06)</td>
</tr>
<tr>
<td></td>
<td>PRED_SCEN</td>
<td>Enter the name of the business case. &lt;PAI Predictive Scenario Name&gt;</td>
</tr>
<tr>
<td></td>
<td>PAI_OTYPE</td>
<td>MVERSION</td>
</tr>
</tbody>
</table>

13. On **Exit Authorization Maintenance**, select **Save**.
14. Select **Generate**.

### 7.10.5 Configuring Business Roles for the Frontend

Configuring ABAP frontend role authorization for **Predictive Models** and **Predictive Scenarios** apps.

#### Authorization and Roles

All access to data and the execution of actions in the system requires authorization. The user must have authorization privileges to perform an operation, and to access the object to which the operation applies. Privileges can be granted to users either directly, or indirectly through roles.

A role is simply a set of access privileges. Roles are the standard mechanism for granting privileges. They allow you to implement different hierarchies of user access that can be modeled on business roles.
If you are using the SAP Fiori Launchpad as the user interface, you must have roles assigned to your Fiori user in the NetWeaver Gateway system.

**SAP Business Roles**

SAP delivers a wide range of business roles as templates for customers. The analytics specialist role called SAP_BR_ANALYTICS_SPECIALIST includes Fiori frontend role menu authorizations for the Predictive Models and Predictive Scenarios apps. It also gives you access to several other catalogs and groups.

To get the necessary privileges for using all features of the Predictive Models and Predictive Scenarios apps, further configuration is required for the frontend and backend of the system. To validate and train predictive models, the user needs the necessary privileges for the Predictive Models app. To review and publish custom predictive use cases, the user needs the necessary privileges for the Predictive Scenarios app.

**Related Information**

Frontend Authorization for Predictive Models [page 45]
Frontend Authorization for Predictive Scenarios [page 44]

### 7.10.5.1 Frontend Authorization for Predictive Scenarios

How to perform frontend ABAP role configuration for predictive scenarios.

**Context**

**Creating Frontend Authorizations**

To utilize the PAi Fiori application, two Fiori (frontend) role menu authorizations are required:

- Predictive Scenarios Fiori Tile Catalog (object SAP_CA_BC_ANA_UMM_PSC)
- Predictive Models Fiori Tile Group (object SAP_CA_BCG_ANA_UMM)

This section briefly describes how you create a frontend authorization role using the PFCG (Profile Generator) transaction code.

Transaction code PFCG is for role maintenance and administration and allows you to manage roles and authorization data. It automatically creates authorization data based on selected menu functions which can then be fine-tuned as required.

**Creating PFCG Authorizations**

Access to Fiori app catalogs and groups is controlled by PFCG authorizations in the ABAP frontend server. Access is granted to end users by assigning roles. You need to add authorizations for Fiori tile catalog (object name SAP_CA_BC_ANA_UMM_PSC) and Fiori tile group (object name SAP_CA_BCG_ANA_UMM).
To create a role for Predictive Scenarios app Fiori tile, do the following:

**Procedure**

1. In the ABAP frontend server, access the activity using the transaction code PFCG.
2. On the Role Maintenance screen, input Role using a suitable role name for use with PAi. Choose Single Role.
3. Enter a description and save your created role.
4. Select the Menu tab.
5. Select SAP Fiori Tile Catalog and as Catalog ID, enter SAP Fiori Tile Catalog SAP_CA_BC_ANA_UMM_PSC - Predictive Scenarios.
7. Select Save.
8. Select Generate.

**7.10.5.2 Frontend Authorization for Predictive Models**

How to perform frontend ABAP role configuration for predictive models.

**Context**

Creating Frontend Authorizations

To utilize the PAi Fiori application, two Fiori (frontend) role menu authorizations are required:

- Predictive Models Fiori Tile Catalog (object SAP_CA_BC_ANA_UMM)
- Predictive Models Fiori Tile Group (object SAP_CA_BCG_ANA_UMM)

This section briefly describes how you create a frontend authorization role using the PFCG (Profile Generator) transaction code.

Transaction code PFCG is for role maintenance and administration, and allows you to manage roles and authorization data. It automatically creates authorization data based on selected menu functions, which can then be fine-tuned as required.

Creating PFCG Authorizations

Access to Fiori app catalogs and groups is controlled by PFCG authorizations in the ABAP frontend server. Access is granted to end users by assigning roles. You need to add authorizations for Fiori tile catalog (object name SAP_CA_BC_ANA_UMM) and Fiori tile group (object name SAP_CA_BCG_ANA_UMM).
To create a role for Predictive Models apps Fiori tile, do the following:

**Procedure**

1. In the ABAP frontend server, access the activity using the transaction code PFCG.
2. On the Role Maintenance screen, input Role using a suitable role name for use with PAi. Choose **Single Role**.
3. Enter a description and save your created role.
4. Select the **Menu** tab.
5. Select **SAP Fiori Tile Catalog** and as **Catalog ID**, enter **SAP Fiori Tile Catalog SAP_CA_BCA_ANA_UFM - Predictive Models**.
6. Select **SAP Fiori Tile Group** and as **Group ID**, enter **SAP Fiori Tile Group SAP_CA_BCG_ANA_UFM - Predictive Models**.
7. Select **Save**.
8. Select **Generate**.

**7.11 Follow-Up Activities for Analytics and Planning**

To enable the use of Analytics with SAP S/4HANA, you need to set up the Analytic Engine. For information how to do so, see SAP Note [2289865](https://new.sap.com/).

To set up embedded BW Reporting as well as SAP BPC for SAP S/4HANA for Finance purposes, please follow the instructions in SAP Note [1972819](https://new.sap.com/).

**7.12 Follow Up Activities in Master Data Governance**

**Gateway Buffering in Test Systems**

To avoid very slow performance, the metadata cache and usage of shared memory for caching options need to be activated. In productive systems, metadata caching is active by default. However, if you are working in test systems you have to activate the Gateway metadata caching (buffering) manually. These settings have to be performed on the frontend system where the Gateway server is installed.

To manually activate these settings, in a test system, you do the following:

1. Go to the Gateway system with transaction /IWFND/MED_ACTIVATE, or in Customizing by the IMG path [SAP NetWeaver ➤ SAP Gateway ➤ OData Channel ➤ Administration ➤ Cache Settings ➤ Metadata ➤ Activate or Deactivate Cache](https://new.sap.com/).
2. Select the **Activate Metadata Cache** check box.
3. Select the *Use Shared Memory for Caching* check box

![Metadata Cache Settings](image)

Manually Applying Settings

### 7.13 Follow-Up Activities for Environment, Health, and Safety

After the installation, you need to carry out the following activities for *Environment, Health, and Safety*:

- In transaction **SICF**, activate all EHFND*, EHENV*, and EHHSS* WebDynpro services below the node `/default_host/sap/bc/webdynpro/sap/`
- Activate the SAPUI5 application handler on the path `/default_host/sap/bc/ui5_ui5` and on the path `/default_host/sap/public/bc/ui5_ui5`
- Copy the delivery Customizing from client 000 into your other clients.
- Make the relevant settings in the Customizing activities for *Environment, Health, and Safety* under *Foundation for EHS* and under *Incident Management, Health and Safety Management*, or *Environment Management*.
- Run report **R_EHFND_CHEM_PROP_MIGRATION** to migrate the chemical properties defined in Customizing activity *Specify Chemical Properties* under *Master Data Configuration* to the content of the *Chemical/ Physical Property* business object. More details are available in the report documentation and SAP Note 3127655.
i Note

In SAP S/4HANA, a new identity model for business users was introduced. You need to create business users before you can use the functions in *Environment, Health, and Safety*.

For more information about creating business users, see SAP Note 2570961.

### 7.14 Follow-Up Activities for Management of Change

After the installation, you need to carry out the following activities for Management of Change:

- In transaction SICF, activate the following WebDynpro services below the node /default_host/sap/bc/webdynpro/moc/:
  - WDA_ACTIVITY
  - WDA_ACTIVITY_CHANGE_LOG
  - WDA_CHANGE_REQUEST
  - WDA_CHGREQ_CHANGE_LOG
- Also activate the following services:
  - NWBC runtime node on the path /default_host/sap/bc/nwbc.
  - SAPUI5 application handler on the path /default_host/sap/bc/ui5_ui5 and on the path /default_host/sap/public/bc/ui5_ui5.
- Copy the delivery Customizing from client 000 into your other clients.
- Make the relevant settings in the Customizing activities for Management of Change under Cross-Application Components » Management of Change.
- Example Customizing is delivered with the hierarchical BC set /MOC/EXAMPLE_CUSTOMIZING.

### 7.15 Follow-Up Activities for Enterprise Portfolio and Project Management
7.15.1 Follow-Up Activities for SAP Portfolio and Project Management

Navigation

To enable the navigation, carry out the following manual steps:

1. Maintain the Customizing settings in SAP Portfolio and Project Management under Portfolio Management > Global Customizing > Process and Service Settings > Navigation Settings; SAP delivers the Customizing entries as standard in the Customizing client.

2. From the delivery client, copy the data from the Customizing tables mentioned below using transaction /n/RPM/CUST_COPY:
   - /RPM/DASH_PERS: Dashboard Customization
   - /RPM/DASH_ROLE: Dashboard Attributes Override Table
   - INM_NAV_CTX: INM Navigation Context
   - INM_NAV_CTX_W: INM Navigation Context Workcenter
   - INM_NAV_INF_W: INM Navigation Information

3. Manually adjust and compare the Customizing data with the delivery client using transaction SCU0.

4. Initially all dashboard fields are displayed as standard fields. With this, it is not possible to navigate to the object windows. To activate the links to the object windows, select the Link checkbox in Customizing for SAP Portfolio and Project Management under Portfolio Management > Global Customizing > Global Field Settings > Dashboard Settings > Define Fields for Dashboards.

   You can also copy the Customizing for the dashboards by copying /RPM/DASHBOARD using transaction /n/RPM/CUST_COPY.

⚠️ Caution

This transaction copies the standard Customizing for all dashboards and invalidates all customer-specific Customizing for the dashboards. Object-type-specific copying is not supported by transaction /n/RPM/CUST_COPY.
7.15.2 Follow-Up Activities for Commercial Project Management

7.15.2.1 Overall Implementation Sequence

This section describes the implementation sequence for Project Workspace, Project Cost and Revenue Planning, and Project Issue and Change Management.

The Release Information Note (SAP Note 3089817) contains important information and references related to Commercial Project Management. Based on your business needs, you can choose one of the following component combinations as a deployment option:

<table>
<thead>
<tr>
<th>Deployment Option</th>
<th>Project Workspace</th>
<th>Project Cost and Revenue Planning</th>
<th>Project Issue and Change Management</th>
<th>SAP BusinessObjects Analysis for Microsoft Office (Analysis Office)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option 1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Option 2</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Option 3</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Option 4</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

**i Note**

By default, sample workbooks are delivered as front-end applications for planning. These sample workbooks require Analysis Office and use the delivered BW-IP content.

As an alternative, you may build your own front-end application using SAP Lumira. Please note that no sample application is delivered by default. For more information, see the following:

- SAP Lumira
- Application Designer Guide: Designing Analysis Applications
- Creating Planning Applications

**Option 1**

Install Project Workspace, Project Cost and Revenue Planning, and Project Issue and Change Management with Analysis Office (AO):

1. Activate the `/CPD/CA_CPD_PWS_1` business function (see transaction SFW5) Enterprise Business Functions `/CPD/CA_CPD_PWS_1`.

   **i Note**

   The activation of the business function `OPS_PS_CI_1` is a prerequisite for working with Project System (PS) projects.

2. Activate the `/CPD/CA_CPD_PFP_1` business function (see transaction SFW5) Enterprise Business Functions `/CPD/CA_CPD_PFP_1`.
3. Activate the /PICM/CA_CPD_PICM_1 business function (see transaction SFW5) Enterprise Business Functions /PICM/CA_CPD_PICM_1).

4. Install NWBC for Desktop (optional).

5. If you wish to use workbooks as the front-end, install Analysis Office (see SAP note 3089817).

6. Enable Planning Application Kit (PAK). PAK allows you to use the workbooks of SAP BusinessObjects Analysis, edition for Microsoft Office as part of the Commercial Project Management content.

Procedure
1. Get the latest information posted in SAP note 1637199.
2. In the back-end system, launch table/view maintenance (transaction SM30).
3. Enter RSPLS_HDB_ACT in the table/view field and choose Maintain.
4. Choose New Entries.
5. In the HANA Intgrtn. Active column, select Deep HANA Integration Active; and in the Functn. Active column, select the checkbox.

7. Commercial Project Management uses the BW layer that is available in each NetWeaver stack.

⚠️ Caution
Project Cost and Revenue Planning uses BW Integrated Planning (BW-IP), which uses real-time InfoCubes to capture data generated through input-ready queries and planning functions. Therefore, only a configuration of the local BI client is required (and not an additional BI system).

For setting up Project Cost and Revenue Planning, see SAP note 2363617.

8. You must activate the analytics content under info-areas/CPD/AVR and /PICM/AVR. For information about setting up Analytics, see SAP Note 1999149.

9. To link generated SQL views of CDS views to HANA views, implement SAP Note 2952636.

10. You must follow these steps to enable delivery customizing in the relevant clients:

1. Go to transaction SFW_BROWSER.
2. Expand the business function /CPD/CA_CPD_PWS_1.
3. Double-click on switch /CPD/CA_CPD_SFWS_PWS_1 to implement BC set activation.
4. Choose the Activate Dependent BC Sets button.
5. In the dialog box, select Activate Switch BC Sets and choose Continue.
6. In the next dialog box, select the following:
   1. Only Logon client for Cascading BC Sets
   2. Activate in logon client for Non-Cascading BC sets
   3. Activate for Cross-Client BC sets
5. Select the checkboxes to ignore previous activations and ignore table delivery class for a new installation.
7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
8. Expand the business function /CPD/CA_CPD_PFP_1.
9. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PFP_1.
10. Expand the business function /PICM/CA_CPD_PICM_1.
11. Repeat the BC set activation steps for the switch /PICM/CA_CPD_SFWS_PICM_1.

11. Check and activate SICF services as follows:
1. Go to transaction SICF.
2. Choose Execute.
3. Go to default host sap bc webdynpro.
4. Ensure that all services under the cpd node are active.
5. Ensure that all services under the picm node are active.

12. BRF+ framework is used within analytics and in the processing of change requests in Project Issue and Change Management. Import the BRF+ customizing application as follows:
   - **Client 000**
     1. Run the report FDT_TRANS.
     2. Provide the relevant customizing request.
     3. Enter the object ID as 3B8EAA71741841EE59EFAD4B491883514.
     4. Enter the object ID as F0D5105146757029E10000000A42852B.
     5. Select the Transport Whole Application(s) radio button.
   - **Productive Client**
     1. Launch the transaction SCC1.
     2. Enter the source client as 000.
     3. Provide the transport request in which you have transported the application (from client 000).
     4. Select the Include Tasks in Requests checkbox.
     5. Execute the transaction.

---

**Option 2**

Install Project Workspace and Project Cost and Revenue Planning with Analysis Office (AO):

1. Activate the /CPD/CA_CPD_PWS_1 business function (see transaction SFW5 Enterprise Business Functions /CPD/CA_CPD_PWS_1).

   **Note**
   The activation of the business function OPS_PS_CI_1 is a prerequisite for working with Project System (PS) projects.

2. Activate the /CPD/CA_CPD_PFP_1 business function (see transaction SFW5 Enterprise Business Functions /CPD/CA_CPD_PFP_1).
3. Install NWBC for Desktop (optional).
4. If you wish to use workbooks as the front-end, install Analysis Office (see SAP note 3089817).
5. Enable Planning Application Kit (PAK). PAK allows you to use the workbooks of SAP BusinessObjects Analysis, edition for Microsoft Office as part of the Commercial Project Management content.

   **Procedure**
   1. Get the latest information posted in SAP note 1637199.
   2. In the back-end system, launch table/view maintenance (transaction SM30).
   3. Enter RSPLS_HDB_ACT in the table/view field and choose Maintain.
   4. Choose New Entries.
   5. In the HANA Integrtn. Active column, select Deep HANA Integration Active; and in the Functn. Active column, select the checkbox.
   6. Commercial Project Management uses the BW layer that is available in each NetWeaver stack.
\textbf{Caution}

Project Cost and Revenue Planning uses BW Integrated Planning (BW-IP), which uses real-time InfoCubes to capture data generated through input-ready queries and planning functions. Therefore, only a configuration of the local BI client is required (and not an additional BI system).

For setting up Project Cost and Revenue Planning, see SAP note \hyperlink{https://support.sap.com/notes/2363617}{2363617}.  

7. You must activate the analytics content under info-area \texttt{/CPD/AVR}. For information about setting up Analytics, see SAP Note \hyperlink{https://support.sap.com/notes/1999149}{1999149}.  

8. To link generated SQL views of CDS views to HANA views, implement SAP Note \hyperlink{https://support.sap.com/notes/2952636}{2952636}.  

9. You must follow these steps to enable delivery customizing in the relevant clients:  
   1. Go to transaction \texttt{SFW_BROWSER}.  
   2. Expand the business function \texttt{/CPD/CA_CPD_PWS_1}.  
   3. Double-click on switch \texttt{/CPD/CA_CPD_SFWS_PWS_1} to implement BC set activation.  
   4. Choose the \texttt{Activate Dependent BC Sets} button.  
   5. In the dialog box, select \texttt{Activate Switch BC Sets} and choose \texttt{Continue}.  

6. In the next dialog box, select the following:  
   1. \texttt{Only Logon client for Cascading BC Sets}  
   2. \texttt{Activate in logon client for Non-Cascading BC sets}  
   3. \texttt{Activate for Cross-Client BC sets}  
   4. Select the checkboxes to ignore previous activations and ignore table delivery class for a new installation  

7. Repeat the BC set activation steps for the switch \texttt{/CPD/CA_CPD_SFWS_PWS_S4_1}.  

8. Expand the business function \texttt{/CPD/CA_CPD_PFP_1}.  

9. Repeat the BC set activation steps for the switch \texttt{/CPD/CA_CPD_SFWS_PFP_1}.  

10. Check and activate SICF services as follows:  
   1. Go to transaction \texttt{SICF}.  
   2. Choose \texttt{Execute}.  
   3. Go to \texttt{default host} \rightarrow \texttt{sap} \rightarrow \texttt{bc} \rightarrow \texttt{webdynpro}.  
   4. Ensure that all services under the \texttt{cpd} node are active.  

11. BRF+ framework is used within analytics. Import the BRF+ customizing application as follows:  
   - \textbf{Client 000}  
     1. Run the report \texttt{FDT_TRANS}.  
     2. Provide the relevant customizing request.  
     3. Enter the object ID as \texttt{38EAA71741841EE59EFA04B91883514}.  
     4. Select the \texttt{Transport Whole Application(s)} radio button.  
   - \textbf{Productive Client}  
     1. Launch the transaction \texttt{SCC1}.  
     2. Enter the source client as \texttt{000}.  
     3. Provide the transport request in which you have transported the application (from client 000).  
     4. Select the \texttt{Include Tasks in Requests} checkbox.  
     5. Execute the transaction.
Option 3

Install Project Workspace and Project Issue and Change Management with Analysis Office (AO):

1. Activate the /CPD/CA_CPD_PWS_1 business function (see transaction SFW5 Enterprise Business Functions /CPD/CA_CPD_PWS_1).

   **Note**
   The activation of the business function OPS_PS_CI_1 is a prerequisite for working with Project System (PS) projects.

2. Activate the /PICM/CA_CPD_PICM_1 business function (see transaction SFW5 Enterprise Business Functions /PICM/CA_CPD_PICM_1).

3. Install NWBC for Desktop (optional).

4. If you wish to use workbooks as the front-end, install Analysis Office (see SAP note 3089817).

5. You must activate the analytics content under info-areas /CPD/AVR and /PICM/AVR. For information about setting up Analytics, see SAP Note 1999149.

6. To link generated SQL views of CDS views to HANA views, implement SAP Note 2952636.

7. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction SFW_BROWSER.
   2. Expand the business function /CPD/CA_CPD_PWS_1.
   3. Double-click on switch /CPD/CA_CPD_SFWS_PWS_1 to implement BC set activation.
   4. Choose the Activate Dependent BC Sets button.
   5. In the dialog box, select Activate Switch BC Sets and choose Continue.
   6. In the next dialog box, select the following:
      1. **Only Logon client for Cascading BC Sets**
      2. **Activate in logon client for Non-Cascading BC sets**
      3. **Activate for Cross-Client BC sets**
      4. Select the checkboxes to ignore previous activations and ignore table delivery class for a new installation.
   7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
   8. Expand the business function /PICM/CA_CPD_PICM_1.
   9. Repeat the BC set activation steps for the switch /PICM/CA_CPD_SFWS_PICM_1.

8. Check and activate SICF services as follows:
   1. Go to transaction SICF.
   2. Choose Execute.
   3. Go to \default host \sap \bc \webdynpro.
   4. Ensure that all services under the cpd node are active.
   5. Ensure that all services under the picm node are active.

9. BRF+ framework is used within analytics and the processing of change requests in Project Issue and Change Management. Import the BRF+ customizing application as follows:
   1. **Client 000**
      1. Run the report FDT_TRANS.
      2. Provide the relevant customizing request.
3. Enter the object ID as 38EAA71741841EE59EFAD4B491883514.
4. Enter the object ID as F0D5105146757029E10000000A42852B.
5. Select the Transport Whole Application(s) radio button.

- **Productive Client**
  1. Launch the transaction SCC1.
  2. Enter the source client as 000.
  3. Provide the transport request in which you have transported the application (from client 000).
  4. Select the Include Tasks in Requests checkbox.
  5. Execute the transaction.

### Option 4

**Install Project Workspace with Analysis Office (AO):**

1. Activate the /CPD/CA_CPDPWS_1 business function (see transaction SFW5 \[Enterprise Business Functions \[/CPD/CA_CPDPWS_1 \]).

   **Note**
   
   The activation of the business function OPS_PS_CI_1 is a prerequisite for working with Project System (PS) projects.

2. Install NWBC for Desktop (optional).
3. If you wish to use workbooks as the front-end application, install Analysis Office (see SAP note 3089817 \[).  
4. You must activate the analytics content under the info-area/CPD/AVR. For information about setting up Analytics, see SAP Note 3089817 \[.  
5. To link generated SQL views of CDS views to HANA views, implement SAP Note 2952636 \[.  
6. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction SFW_BROWSER.
   2. Expand the business function /CPD/CA_CPD_PWS_1.
   3. Double-click on switch /CPD/CA_CPDPWS_PWS_1 to implement BC set activation.
   4. Choose the Activate Dependent BC Sets button.
   5. In the dialog box, select Activate Switch BC Sets and choose Continue.
   6. In the next dialog box, select the following:
      1. Only Logon client for Cascading BC Sets
      2. Activate in logon client for Non-Cascading BC sets
      3. Activate for Cross-Client BC sets
      4. Select the checkboxes to ignore previous activations and ignore table delivery class for a new installation.
   7. Repeat the BC set activation steps for the switch /CPD/CA_CPDPWS_PWS_S4_1.
    8. Check and activate SICF services as follows:
       1. Go to transaction SICF.
       2. Choose Execute.
3. Go to default host sap bc webdynpro.
4. Ensure that all services under the cpd node are active.

8. BRF+ framework is used within analytics. Import the BRF+ customizing application as follows:
   ○ Client 000
     1. Run the report FDT_TRANS.
     2. Provide the relevant customizing request.
     3. Enter the object ID as 38EAA71741841EE59EFA04B491888314.
     4. Select the Transport Whole Application(s) radio button.
   ○ Productive Client
     1. Launch the transaction SCC1.
     2. Enter the source client as 000.
     3. Provide the transport request in which you have transported the application (from client 000).
     4. Select the checkbox Include Tasks in Requests.
     5. Execute the transaction.

7.15.2.2 Settings for Project Workspace

Schema Mapping

For the HANA content of Commercial Project Management, you must map the SAP_ECC schema to the SAP <SID> schema.

Configuration of Display Options forAnalytical Reports

Analytical UIBBs are used in Project Workspace to display reports such as Progress Analysis, Work in Progress, and Project Cost Status. By default, these reports are displayed in a SAP List Viewer (ALV) table. However, you can also choose to view these reports as a graphic, or a table and graphic, or using Crystal Reports. To enable additional options for displaying reports, it is necessary to make the following Customizing settings:

To configure options for Graphic and Table and Graphic displays, follow these steps:

1. In Customizing for SAP NetWeaver, choose UI Technologies SAP List Viewer (ALV) Maintain Web Dynpro ABAP-Specific Settings.
2. Select the Java Server Available checkbox.

   i Note
   The display options are available in the frontend only if you also have enabled a Java server.

To configure options for Crystal Reports, follow these steps:

1. In Customizing for SAP NetWeaver, choose UI Technologies SAP List Viewer (ALV) Maintain SAP GUI-Specific Settings.
2. Select the Allow Crystal Reports checkbox.

**Note**
- Commercial Project Management does not deliver any Crystal Report template for viewing reports.
- Crystal reporting requires a special viewer in the frontend. This setting is only meaningful if this viewer has been installed. For more information, see SAP note [1353044](#).

### Set-Up for Launching Native Transactions in Project Workspace

To launch native SAP transactions using the launchpad in Project Workspace, you must activate the MIME Repository service in the following way:

2. On the Maintain Services screen, select the hierarchy type Service and choose Execute.
3. In the Virtual Hosts / Services hierarchy, navigate to the MIME Repository service by choosing default_host > sap > public > bc > its > mimes.
4. Right-click and choose Activate Service.

### Definition of RFC Destinations for Charts

The Fiori-themed analytics content of Commercial Project Management uses charts based on WebDynpro ABAP technology. To connect the IGS (Internet Graphics Server) to the SAP system, you have to create an RFC destination in the SAP system. For more information, see SAP note [454042](#).

### Activation of Relevant OData Services

In Commercial Project Management, the following OData services must be activated:

- CPD_MASTERPROJECT_OVERVIEW_SRV
- CPD_PROJECT_ACTIVITIES_SRV

### Installation and Upgrade of BW

For information about the new and changed objects in this release, see SAP note [2526289](#).
Enabling Enterprise Search

In Commercial Project Management, the following search connectors must be set up:

- Commercial Project
  - Model Name: MASTERPROJECT_H
  - Connector Name: Commercial Project
- Financial Plan
  - Model Name: FINANCIALPLAN_H
  - Connector Name: Financial Plan
- Change Request
  - Model Name: CHANGEREQUEST_H
  - Connector Name: Change Request (Commercial Project)
- Issue
  - ISSUechANGEREQ_H
  - Connector Name: Issue (Commercial Project)

The connector ID is generated automatically when the connector is created and the name of the connector can be edited. For more information, see SAP note 2382734."}

Role for Adding Fiori Apps in the Fiori Launchpad

To add the Fiori apps of Commercial Project Management in the Fiori launchpad, the following roles are required:

- SAP_BR_PROJECTMGR_COMMPRJ (Project Manager (CPM))
- SAP_BR_PRJTEAMMEMBER_COMMPRJ (Project Team Member (CPM))

Set-Up for Linking Commercial Projects to CRM Opportunities

To be able to link commercial projects to CRM opportunities, you must provide the HTTP connection to the CRM system (by defining the RFC destination (CPD_CRM) (connection type H)).

Predefinition of Project Workspace Views

For the predefinition of Project Workspace views for the personalization for end users, see SAP note 2011052.
7.15.2.3 Settings for Project Cost and Revenue Planning

Schema Mapping

For the HANA content of Commercial Project Management, you must map the SAP_ECC schema to the SAP <SID> schema.

Set-Up of the Planning Group

After installing the latest SP of SAP Analysis for Microsoft Office, follow these steps to activate the default planning options in workbooks:

1. Launch a planning workbook and navigate to File > Commercial Project > Settings.
2. In the Settings dialog box, choose the Advanced tab, select Show Planning Group.
3. Close and relaunch the planning workbook.

Set-Up of SAP Multiresource Scheduling (MRS)

Project Cost and Revenue Planning allows you to update staffing information in SAP Multiresource Scheduling. For more information about the compatibility of Commercial Project Management with SAP Multiresource Scheduling, see SAP Note 2363617.

Enhancing Workbooks for SAP Analysis for Microsoft Office

The delivered workbooks contain input-ready queries and planning objects, launched in a Microsoft Excel-based frontend for planning. We recommend that you use the delivered workbooks as templates and create your own workbooks to suit individual requirements. To know more about creating planning workbooks, see the relevant guides in https://help.sap.com/viewer/p/SAP_BUSINESSOBJECTS_ANALYSIS_OFFICE. We also recommend that you use the delivered input-ready queries as templates and create your own queries to suit your requirements.

Disabling the Intelligent Double-Click Function in SAP Analysis for Microsoft Office

i Note

This setting is available only in SAP Analysis for Microsoft Office 1.4 SP02 and above.
When you double-click a cell, the intelligent double-click function (if enabled) automatically executes the first command in the context menu of the cell.

To disable the intelligent double-click function, do the following:

1. Launch Registry Editor. To know more about maintaining registry settings for SAP Analysis for Microsoft Office, see the relevant guides in https://help.sap.com/viewer/p/SAP_BUSINESSOBJECTS_ANALYSIS_OFFICE.
2. Depending on the type of installation, do one of the following:
   ○ If you are using a 32-bit operating system, locate the AdvancedAnalysis folder either under HKEY_CURRENT_USER\Software\SAP or HKEY_LOCAL_MACHINE\Software\SAP.
   ○ If you are using a 64-bit operating system, locate the Wow6432Node either under HKEY_CURRENT_USER\Software\SAP or HKEY_LOCAL_MACHINE\Software\SAP.
3. In the identified path, create nested keys to form the path "\Software\SAP\AdvancedAnalysis\Settings \ExcelGrid.
4. Under ExcelGrid, create the string EnableDoubleClick, and enter the value False.

Installation and Upgrade of BW

For information about the new and changed objects in this release, see SAP note 2522216.

Enhancing HANA Views to Add New Resources

For more information about enhancing HANA views to add new resources, see SAP note 2560000.

Data Consistency of Forecasting Method Descriptions During Upgrade

If you upgrade to Commercial Project Management 1709 onwards from the lower add-on releases SAP Commercial Project Management for S/4HANA 2.0 SP01 and SP02, you must execute the following report to ensure data consistency of forecasting method descriptions: /CPD/PFP_FORECAST_DATA_TRANS

Clean-Up of Invalid FBI Structures

To clean up invalid FPM BOPF Integration (FBI) structures, you must run the /BOFU/R_FBI_VIEW_CLEANUP_DDIC report.

1. In transaction SE38, run /BOFU/R_FBI_VIEW_CLEANUP_DDIC
2. In the selection screen, remove the checks in the following checkboxes:
   ○ Inactive Only
   ○ Deleted Objects Only
3. Choose Execute

4. The system lists inconsistent objects (from the following list). Select the objects that are listed by the system.
   - **Business Object**
     - /BOBF/ATTACHMENT_FOLDER
   - **FBI View**
     - /CPD/PWS_MP_STEXT
     - /CPD/PWS_MP_LIST
     - /BOFU/VIEW_ATF_DOC
     - /BOFU/VIEW_ATF
     - /CPD/WDC_FPP_HEADER_TEXT_FBIVIEW
     - /CPD/WDC_FPP_HEADER_FBIVIEW
     - /CPD/WDC_FPP_VERSION_FBIVIEW
     - /CPD/WDC_FPP_STRUCTURE_FBIVIEW
     - /CPD/PWS_MP_PROJ_MEMBER
     - /CPD/PWS_PM
     - /CPD/PWS_TEAM_ROLES
     - /CPD/FPP_DETAIL_MAPPING_FBIVIEW

5. Choose **Cleanup**.

### 7.15.2.4 Conversion-Relevant Information

After conversion to SAP S/4 HANA, the system automatically retains the data and configuration. The following table provides the simplification list for Commercial Project Management delivered in SAP S/4 HANA:

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2318716</td>
<td>S4TWL – Rate Card</td>
</tr>
<tr>
<td>2318733</td>
<td>S4TWL – Interface of SAP Commercial Project Management with SAP Cloud for Customer</td>
</tr>
<tr>
<td>2320143</td>
<td>S4TWL – Fiori Apps of SAP Commercial Project Management</td>
</tr>
<tr>
<td>2318728</td>
<td>S4TWL – Launchpads of Gantt Chart and Commercial Project Inception</td>
</tr>
<tr>
<td>2323806</td>
<td>S4TWL – Workbooks Delivered in Project Cost and Revenue Planning</td>
</tr>
<tr>
<td>2712156</td>
<td>S4TWL - CPM - Personal Activity List</td>
</tr>
<tr>
<td>2711002</td>
<td>S4TWL - CPM - Forecast from financial plan versions</td>
</tr>
<tr>
<td>2719743</td>
<td>Commercial Project Management: Migrate Configuration Settings of Key Figures and Resource Types for Analytics</td>
</tr>
</tbody>
</table>
### 7.16 Follow-Up Activities for Product Safety and Stewardship

Verify and carry out all Customizing steps under [SAP Customizing Implementation Guide](#) > Product Safety and Stewardship.

### 7.16.1 Follow-Up Activities for Product Compliance for Discrete Industries

For successful installation, always check the release information note [2278589](#) for the most current implementation details.

After the installation, carry out the following activities for Product Compliance for Discrete Industries:

- Verify and activate the following BC sets depending on the processes you need.
  - For the process Managing Product Compliance:
    - `EHPRC_SPECIAL` Critical PRC Customizing from other components
    - `EHPRC_BASIC` Customizing for Product and REACH Compliance
    - `EHPRC_DI_PRODUCT_COMPLIANCE` Managing Product Compliance
  - For the process Managing IMDS Compliance:
    - `EHPRC_SPECIAL` Critical PRC Customizing from other components
    - `EHPRC_BASIC` Customizing for Product and REACH Compliance
    - `EHPRC_DI_IMDS_COMP` Managing IMDS Compliance
  - For both above mentioned processes:
    - `EHPRC_SPECIAL` Critical PRC Customizing from other components
    - `EHPRC_BASIC` Customizing for Product and REACH Compliance
    - `EHPRC_DI` Customizing for Product Compliance
- Verify and carry out all Customizing steps under [SAP Customizing Implementation Guide](#) > Product Safety and Stewardship > Product Compliance for Discrete Industries.
- In transaction `SICF`, activate the following WebDynpro services below the node `/default_host/sap/bc/webdynpro/sap/`:
  - `All EHFND*` and `EHPRC*` services
Also activate the following services:
- NWBC runtime node on the path /default_host/sap/bc/nwbc.
- SAPUI5 application handler on the path /default_host/sap/bc/ui5_ui5.

7.16.2 Follow-Up Activities for Product Safety and Stewardship for Process Industries

For successful installation, always check the release information note 2278589 for the most current implementation details.

After the installation, you need to carry out follow-up activities as described in the following SAP Notes:

- Verify and carry out all Customizing steps under SAP Customizing Implementation Guide > Product Safety and Stewardship > Product Compliance for Process Industries.
- For information regarding installation instructions for Windows Wordprocessor Integration (WWI) and Expert / Open Content Connector (OCC), see SAP Note 568302.
- For information regarding installation instructions for the WWI server, see SAP Note 1394553.

7.17 Follow-Up Activities for Product Compliance


You must copy the delivery Customizing for Product Compliance from client 000 to your system-relevant clients. To compare the Customizing content contained in these clients, execute the transaction Customizing Cross-System Viewer (SCU0) and run a full comparison for the Product Compliance node of the SAP Reference IMG.

See also SAP Note 2972572.
7.18 Follow-Up Activities for Supplier Management

After the installation, you need to carry out the following activities for Supplier Management:

**Delivery Customizing**

You have to copy the delivery Customizing for Supplier Management from client 000 to your relevant clients. You can run transaction Customizing Cross-System Viewer (SCU0) to compare Customizing contents in the 000 client and in the client in your system. For Supplier Management, the following application components are relevant:

- **SLC-EVL, SLC-ACT, SLC-CAT** for Supplier Management Customizing
- **BC-SRV-NUM** for number range intervals required for purchasing categories, activities, tasks, and for the objects used in Supplier Evaluation
- **BC-SEC-AUT-PFC** for PFCG role Customizing

In addition, you must copy alert texts with text ID ‘ALRT’ and text names EVAL_REMINDER* and TASK* to the productive client. For more information, see SAP Note 601619.

**Important SAP Notes**

Define the system characteristic as described in SAP Note 2224695.

**Activate Internet Communication Framework (ICF) Services**

For information about the ICF services that you have to activate for Supplier Management, see the configuration information for Supplier Management. This documentation is included in the product assistance for SAP S/4HANA that is available on SAP Help Portal at https://help.sap.com/s4hana_op_2021.

**i Note**

This documentation also contains further information about the implementation of Supplier Management, such as jobs that must be scheduled and roles that need to be assigned.
7.19 Follow-Up Activities for Human Resources (Compatibility Packs)

7.19.1 Employee-Business Partner Synchronization

The following steps enable you to synchronize employee information with BPs. This synchronization is a mandatory activity for SAP S/4HANA to make sure the follow-up activities and the CDS views work.

For more information, you can also refer to the corresponding Customizing documentation under Personnel Management > SAP S/4HANA for Human Resources > Synchronize Business Partners for SAP HCM Employee Roles (when business function /SHCM/EE_BP_1 is switched off) or Personnel Management > SAP S/4HANA for Human Resources > Synchronize Business Partners with an Active Business Partner Integration (when business function /SHCM/EE_BP_1 is switched on).

For more information on selection, refer to the documentation of the report /SHCM/RH_SYNC_BUPA_FROM_EMPL.

i Note

- Initial synchronization of all employees must be done during the initial business downtime before the production starts.
- In case of large volume of employee data, standard report /SHCM/RH_SYNC_BUPA_FROM_EMPL may take a lot of time to synchronize the employees. Refer to the corresponding FAQ note for 2409229 to process the employees in parallel jobs.

Notes (SAP S/4HANA)

Report HRALXSYNC

You cannot use this synchronization report for employee synchronization in SAP S/4HANA. For any other object synchronization (for example, organizational units), you can use it.

Transaction PRAA

This transaction was used for Vendor creation in the SAP ERP system for travel expenses. This transaction is no longer valid in the SAP S/4HANA system.

Prerequisites

- Set the following switches in the table T77SO:
  - Set HRALX HRAC to 'X' and HRALX PB Pon to 'ON'
  - HRALX ENUMB (type of number assignment for BPs with Employment role) and HRALX ESUBG (subgroup of the number range interval for BPs with Employment role): Use these switches to provide
information regarding types of number assignment and subgroups of number range intervals for BPs with Employment role.

- **HRALX PNUMB** (Business Partner Number Assignment Employee) and **HRALX PSUBG** (Business Partner Subgroup Employee): Use these switches to provide different number ranges to BPs.

- **PLOGI PLOGI** Integration Plan Version / Active Plan Version: Use this switch to determine the active integrated plan version.

**Tip**

For additional information on same numbers, visit the FAQ via SAP Note 3023906.

**i Note**

All other switches under **HRALX** are not relevant in SAP S/4HANA for employee-BP synchronization.

- Execute the relevant BP Customizing activities for the CVI and Vendor account.

**Tip**

Refer to the FAQs in SAP Note 2713963 for additional information. Under Where can I find the guide for Business Partner conversion Activities - Customer Vendor Integration (CVI)?, you will also find the link to a cookbook that provides further details.

- CP should exist for all the employee records (HRP1001 table should have CP-P relationship record for all the employees).

- All the employees should have at least infotype 0 (Actions), 1 (Organizational Assignment) and 2 (Personal Data) maintained.

- You need to install the following notes before you can start replicating employee master data and organizational data:
  - 2539457: BP is created in Person category during Vendor creation or conversion when CVI is active.
  - 2542175: Employee BP is reused during Vendor creation or conversion when CVI is active.
  - 2517507: Reference Vendor data, company code, and bank account are created based on HR master data.
  - 2568251: Invalid BP assignments are deleted.
  - 2991508: Use of business partner identification type ‘Employee ID’ (HCM001)

- To maintain HR master data for external employees, create an active implementation of the Business Add-In **BAdi: Contingent Worker** (SHCM/B_EXTERNAL_EMPLOYEE). For further information, refer to SAP Note 2340095.

**7.19.1.1 SAP S/4HANA Business Partner Synchronization Report and Role Synchronization Report**

**Business Partner Synchronization**

You can use the BP Synchronization Report ( /SHCM/RH_SYNC_BUPA_FROM_EMPL) to synchronize employee data stored in HCM master data persistences (infotypes) with the BP and Vendor as well as to link BPs to users (if infotype 105, subtype 0001 is maintained) and to the corresponding workplace address.

The BP Synchronization Report has the following functions:
Synchronizing the HCM infotypes of new employees
Synchronizing employees who haven’t been synchronized successfully during the last synchronization run
Synchronizing employees with split records

For more information, you can also refer to the Customizing under \Personnel Management\ SAP S/4HANA for Human Resources.

Data is synchronized if employee data is created or changed in the following ways:

- Inbound processing using ALE
  The synchronization is triggered using the following BAdI implementation: HRALE00INBOUND_IDOC: /SHCM/BUPA_SYNC_TRIG

  Note
  By default, this implementation is not active.

- Personnel master data maintenance (for example, transaction PA30/PA40)

  Note
  - Certain HCM master data is time-independent but some BP data is not. Therefore, schedule this report to run on a daily basis (or according to your required frequency) to update the BPs and receive up-to-date employee data.
  - If a synchronization is unsuccessful, all the employee data is updated in the next synchronization run.

Role Synchronization

You can use the Role Synchronization Report (technical name: /SHCM/R_EMLHDLE_BPRLES_DELTA) to update or delete additional roles of personnel numbers with an existing BP instance with the Employment role. If the additional roles already exist (to be found in table /SHCM/D_RLE_SYNC), the system only updates the according BP master data.

The system updates the BPs with additional roles associated to the personnel numbers for which the BP synchronization has been executed by means of the above-mentioned reports. By this, you can flexibly adapt the roles in case of change of main employment.

For more information, you can also refer to the Customizing under \Personnel Management\ SAP S/4HANA for Human Resources.

Field mapping used for employee synchronization

BP Fields:

- BP grouping: If BP grouping is created with BPEE, it will be considered for BP creation in another way:
  1. If switch HRLAX PNUMB is 1 and an internal number range scenario exists, set value ‘True’ to XINST (Standard Grouping for Internal Number Assignment) for the BP grouping; by this, BP group of internal number range type and field XINST is considered.
  2. If HRLAX PNUMB is 2 or 3, BP grouping should be the same as for switch HRLAX PSUBG in T7780.
- BP category: 1 (Person)
• Identification Category:
  ○ Employee: HCM001
  ○ Service Performer Contract: HCM003

• Identification ID: in case of CE or single assignment, the smallest active PERNR is used. In case of SAP SuccessFactors Integration, the same PERNR or 105-ECUS is used.

• Roles:
  ○ Employee: BUP003, until 1511 SP1: FLVN01, for 1511 SP2 and higher releases: FLVN00
  ○ External Employee: BBP005 and BUP011

<table>
<thead>
<tr>
<th>Field description</th>
<th>Infotype</th>
<th>Field Name</th>
<th>Comments</th>
<th>BP Field name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>First Name</td>
<td>VORNA</td>
<td></td>
<td>BUT000 · NAME_FIRST</td>
</tr>
<tr>
<td></td>
<td>Last Name</td>
<td>NACHN</td>
<td></td>
<td>BUT000 · NAME_LAST</td>
</tr>
<tr>
<td></td>
<td>Middle Name</td>
<td>MIDNM</td>
<td></td>
<td>BUT000 · NAME_MIDDLE</td>
</tr>
<tr>
<td></td>
<td>Second Name</td>
<td>NACH2</td>
<td></td>
<td>BUT000 · NAME_LST2</td>
</tr>
<tr>
<td></td>
<td>Initials</td>
<td>INITS</td>
<td></td>
<td>BUT000 · INITIALS</td>
</tr>
<tr>
<td></td>
<td>Academic Title 1</td>
<td>TITEL</td>
<td>TSAD2</td>
<td>BUT000-TITLE_ACA1</td>
</tr>
<tr>
<td></td>
<td>Title</td>
<td>Based on ANRED and GESCH</td>
<td>BBP_TSAD3HR or TSAD3HR</td>
<td>BUT000 · TITLE</td>
</tr>
<tr>
<td></td>
<td>Academic Title 2</td>
<td>TITL2</td>
<td>TSAD2</td>
<td>BUT000-TITLE_ACA2</td>
</tr>
<tr>
<td></td>
<td>Name Supplement</td>
<td>NAMZU</td>
<td>TSAD5</td>
<td>BUT000 · TITLE_ROYL</td>
</tr>
<tr>
<td></td>
<td>Name Affix 1</td>
<td>VORSW</td>
<td>TSAD4</td>
<td>BUT000 · PREFIX1</td>
</tr>
<tr>
<td></td>
<td>Name Affix 2</td>
<td>VORS2</td>
<td>TSAD4</td>
<td>BUT000 · PREFIX2</td>
</tr>
<tr>
<td></td>
<td>Gender</td>
<td>GESCH</td>
<td></td>
<td>BUT000 · XSEXF or XSEXFM</td>
</tr>
</tbody>
</table>

**Restriction**

For external employees, the payment data and the address data is not synchronized.
<table>
<thead>
<tr>
<th>Field description</th>
<th>Infotype</th>
<th>Field Name</th>
<th>Comments</th>
<th>BP Field name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferred Language</td>
<td>2</td>
<td>SPRSL</td>
<td></td>
<td>BUT000 - LANGU _CORR</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BUT000 - BU_LANGU</td>
</tr>
<tr>
<td>Nationality</td>
<td>2</td>
<td>NATIO</td>
<td></td>
<td>BUT000 - NATIO</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>2</td>
<td>GBDAT</td>
<td></td>
<td>BUT000 - BIRTHDT</td>
</tr>
<tr>
<td>Name at Birth</td>
<td>2</td>
<td>NAME2</td>
<td></td>
<td>BUT000 - NAME_LAST2</td>
</tr>
<tr>
<td>Nick name</td>
<td>2</td>
<td>RUFNM</td>
<td></td>
<td>BUT000 - NICK-NAME</td>
</tr>
<tr>
<td>Place of Birth</td>
<td>2</td>
<td>GBORT</td>
<td></td>
<td>BUT000 - BIRTHPL</td>
</tr>
<tr>
<td>Marital Status</td>
<td>2</td>
<td>FAMST</td>
<td>BBP_TSAD3HR or TB027HR</td>
<td>BUT000 - MARST</td>
</tr>
<tr>
<td>Search term 1</td>
<td>2</td>
<td>NCHMC</td>
<td></td>
<td>BUT000 - BU_SORT1</td>
</tr>
<tr>
<td>Search term 2</td>
<td>2</td>
<td>VNAMC</td>
<td></td>
<td>BUT000 - BU_SORT2</td>
</tr>
<tr>
<td>Full Name</td>
<td>2</td>
<td></td>
<td>CNAME or ENAME or Concatenation of VORNA MIDNM NACHN</td>
<td>BUT000 - NAME1_TEXT</td>
</tr>
<tr>
<td>Communication</td>
<td></td>
<td></td>
<td>Subtype 0010</td>
<td>ADR6-SMTP_ADDR</td>
</tr>
<tr>
<td>E-Mail Address</td>
<td>105</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td></td>
<td></td>
<td>From Date 6</td>
<td>BUT020 - ADDR_VALID_FROM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BEGDA</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>End Date 6</td>
<td>BUT020 - ADDR_VALID_TO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ENDDA</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>6</td>
<td>LAND1</td>
<td></td>
<td>ADRC - COUNTRY</td>
</tr>
<tr>
<td>Region</td>
<td>6</td>
<td>STATE</td>
<td></td>
<td>ADRC - REGION</td>
</tr>
<tr>
<td>Field description</td>
<td>Infotype</td>
<td>Field Name</td>
<td>Comments</td>
<td>BP Field name</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------</td>
<td>------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>City</td>
<td>6</td>
<td>ORT01</td>
<td></td>
<td>ADRC -CITY1</td>
</tr>
<tr>
<td>District</td>
<td>6</td>
<td>ORT02</td>
<td></td>
<td>ADRC -CITY2</td>
</tr>
<tr>
<td>Postal Code</td>
<td>6</td>
<td>PSTLZ</td>
<td></td>
<td>ADRC - POST_CODE1</td>
</tr>
<tr>
<td>Street</td>
<td>6</td>
<td>STRAS</td>
<td></td>
<td>ADRC - STREET</td>
</tr>
<tr>
<td>Street 2</td>
<td>6</td>
<td>ADR03</td>
<td></td>
<td>ADRC - STR_SUPPL1</td>
</tr>
<tr>
<td>Street 3</td>
<td>6</td>
<td>ADR04</td>
<td></td>
<td>ADRC - STR_SUPPL2</td>
</tr>
<tr>
<td>Street 4</td>
<td>6</td>
<td>LOCAT</td>
<td></td>
<td>ADRC - STR_SUPPL3</td>
</tr>
<tr>
<td>House number supplement</td>
<td>6</td>
<td>POSTA</td>
<td></td>
<td>ADRC - HOUSE_NUM2</td>
</tr>
<tr>
<td>c/o</td>
<td>6</td>
<td>NAME2</td>
<td></td>
<td>ADRC - NAME_CO</td>
</tr>
<tr>
<td>Building Code</td>
<td>6</td>
<td>BLDNG</td>
<td></td>
<td>ADRC - BUILDING</td>
</tr>
<tr>
<td>Floor</td>
<td>6</td>
<td>FLOOR</td>
<td></td>
<td>ADRC - FLOOR</td>
</tr>
<tr>
<td>House Number</td>
<td>6</td>
<td>HSNMR</td>
<td></td>
<td>ADRC - HOUSE_NUM1</td>
</tr>
<tr>
<td>Telephone</td>
<td>6</td>
<td>TLNR</td>
<td></td>
<td>ADCP - TEL_NUM-BER</td>
</tr>
<tr>
<td>Payment</td>
<td>1</td>
<td>EMFTX</td>
<td>If infotype 9- EMFTX is not present: map infotype 1 ENAME</td>
<td>BUTOBK-KOINH</td>
</tr>
<tr>
<td>Bank</td>
<td>9</td>
<td>BANKS</td>
<td>If Travel Expenses (subtype 2) Bank information exists, it is synchronized with BP or Vendor; otherwise, Main Bank (subtype 0) is synchronized. If both do not exist, Vendor will not be created.</td>
<td>BUTOBK - BANKS</td>
</tr>
<tr>
<td>Bank Account</td>
<td>9</td>
<td>BANKN</td>
<td></td>
<td>BUTOBK - BANKN</td>
</tr>
<tr>
<td>Control Key</td>
<td>9</td>
<td>BKONT</td>
<td></td>
<td>BUTOBK - BKONT</td>
</tr>
<tr>
<td>Bank Key</td>
<td>9</td>
<td>BANKL</td>
<td></td>
<td>BUTOBK - BANKL</td>
</tr>
<tr>
<td>Reference specifications for bank details</td>
<td>9</td>
<td>BKREF</td>
<td></td>
<td>BUTOBK - BKREF</td>
</tr>
<tr>
<td>Field description</td>
<td>Infotype</td>
<td>Field Name</td>
<td>Comments</td>
<td>BP Field name</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>IBAN No.</td>
<td>9</td>
<td>IBAN</td>
<td></td>
<td>BUT0BK - IBAN</td>
</tr>
<tr>
<td>Valid From</td>
<td>9</td>
<td>BEGDA</td>
<td></td>
<td>BUT0BK - BK_VALID_FROM</td>
</tr>
<tr>
<td>Valid To</td>
<td>9</td>
<td>ENDDA</td>
<td></td>
<td>BUT0BK - BK_VALID_TO</td>
</tr>
<tr>
<td>Vendor Company Code</td>
<td>BUKRS</td>
<td>1</td>
<td></td>
<td>LFB1 - BUKRS</td>
</tr>
<tr>
<td></td>
<td>ZLSCH</td>
<td>9</td>
<td></td>
<td>LFB1 - ZWELS</td>
</tr>
<tr>
<td></td>
<td>PERNR</td>
<td>1</td>
<td></td>
<td>LFB1 - PERNR</td>
</tr>
<tr>
<td>Reconciliation account</td>
<td>(see comment)</td>
<td>Read from /SCHM/ RECON based on Employee’s company code (IT0001-BUKRS)</td>
<td>LFB1 - AKONT</td>
<td></td>
</tr>
</tbody>
</table>

**iNote**

You can maintain the view PTRV_VENDOR_SYNC per company code to fulfill the additional requirements concerning:

- Roles
- Source of company code for company code segments
- Source of subtype for address
- Additional information for Vendor company code segments (LFB1), Vendor general data (LFA1) as well as for dunning data (LFB5) and withholding tax data (LFBW)
- Source of bank account, bank account key on BP as well as partner bank type in Vendor bank data LFBK
- Setting payment locks for inactive employees
- Used identification categories for loosely coupled BPs
- Address types to be used for BPs

Either refer to the F1 help for the fields in maintenance view PTRV_VENDOR_SYNC or read the knowledge-based article 2632026 to learn more about the usage of the control table PTRV_VENDOR_SYNC.

**Field mapping for Workplace Address:**

- In case User (infotype 105, subtype 0001) is maintained for the employee: During employee synchronization, if the user is of type 00 (user’s old type 3 address USR21-IDADTYPE: 00), the existing workplace address data is retained and only the following information is updated or overwritten (if present in the infotypes).
- If no user is maintained, following information is updated as workplace address.
You can use the view TBZ_V_EEWA_SRC to maintain the address data for users with a business partner assignment. For more information, see SAP Note 2813203.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Infotype</th>
<th>Field Name</th>
<th>Comments</th>
<th>BP Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>1</td>
<td>ORGEH</td>
<td>Text from organizational unit (ORGEH) from table T527X</td>
<td>ADCP - DEPARTMENT</td>
</tr>
<tr>
<td>Function</td>
<td>1</td>
<td>STELL</td>
<td>Text from job (STELL) from table T513S</td>
<td>ADCP - FUNCTION</td>
</tr>
<tr>
<td>Room Number</td>
<td>32</td>
<td>ZIMNR</td>
<td></td>
<td>ADCP - roomnumber</td>
</tr>
<tr>
<td>Building Number</td>
<td>32</td>
<td>GEBNR</td>
<td></td>
<td>ADCP - building</td>
</tr>
<tr>
<td>Telephone</td>
<td>105</td>
<td></td>
<td>If SAP SuccessFactors integration is used, infotype 105, subtype ECPB is used; otherwise, infotype 105, subtype 0020 is used.</td>
<td>ADR2 - telnr_long</td>
</tr>
<tr>
<td>Cell Phone</td>
<td>105</td>
<td></td>
<td>If SAP SuccessFactors integration is used, infotype 105, subtype ECPC is used; otherwise, Infotype 105, subtype CELL is used.</td>
<td>ADR2 - telnr_long</td>
</tr>
<tr>
<td>E-Mail Address</td>
<td>105</td>
<td></td>
<td>Infotype 105, subtype 10</td>
<td>ADR6 - flgdefault = 'X' ADR6 - SMTP_ADDR</td>
</tr>
</tbody>
</table>

### 7.19.1.1.1 Authorizations

Human Resources uses the authorization concept provided by AS ABAP or AS Java. Therefore, the recommendations and guidelines for authorizations as described in the SAP NetWeaver AS Security Guide ABAP and SAP NetWeaver AS Security Guide Java also apply.

The SAP NetWeaver authorization concept is based on assigning authorizations to users based on roles. For role maintenance, use the profile generator (transaction PFCG) on the AS ABAP and the User Management Engine’s user administration console on the AS Java.
Standard Roles

The table below shows the standard roles that are used.

<table>
<thead>
<tr>
<th>Role</th>
<th>Front-end Role</th>
<th>Back-end Role</th>
<th>Both (Front-end + Back-end)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_BR_ADMINISTRATOR_HRINFO</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Administrator App (For example, Monitoring Employee Synchronization)</td>
</tr>
<tr>
<td>SAP_BR_EMPLOYEE</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Employee can search and display an overview of the employee data in Employee factsheet</td>
</tr>
</tbody>
</table>

Standard Authorization Objects

The table below shows the security-relevant authorization objects that are used.

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B_BUPA_ADR (Business Partner: BP Addresses)</td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SENSTVT</td>
<td>Sensitivity</td>
<td></td>
</tr>
<tr>
<td>B_BUPA_BNK (Business Partner: BP Banks)</td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SENSTVT</td>
<td>Sensitivity</td>
<td></td>
</tr>
<tr>
<td>B_BUPA_RLT (Business Partner: BP Roles)</td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RLTYP</td>
<td>BP Role</td>
<td></td>
</tr>
<tr>
<td>B_BUPA_GRP</td>
<td>BEGRU</td>
<td>Authorization Group</td>
<td></td>
</tr>
<tr>
<td>Authorization Object</td>
<td>Field</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------</td>
<td>---------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td>ACTVT</td>
<td></td>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td>B_BUP_PCPT</td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td>F_LFA1_APP (Vendor: Application Authorization)</td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>APPKZ</td>
<td></td>
<td>Customer and Vendor Master Data Application Authorization</td>
</tr>
<tr>
<td>F_LFA1_BUK (Vendor: Authorization for Company Codes)</td>
<td>BUKRS</td>
<td></td>
<td>Company Code</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td>F_LFA1_GEN (Vendor: Central Data)</td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td>F_LFA1_GRP (Vendor: Account Group Authorization)</td>
<td>KTOKK</td>
<td></td>
<td>Vendor account group</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td>P_ORGIN (HR: Master Data)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>INFTY</td>
<td></td>
<td>Infotype</td>
</tr>
<tr>
<td></td>
<td>SUBTY</td>
<td></td>
<td>Subtype</td>
</tr>
<tr>
<td></td>
<td>AUTHC</td>
<td></td>
<td>Authorization level</td>
</tr>
<tr>
<td></td>
<td>PERSA</td>
<td></td>
<td>Personnel Area</td>
</tr>
<tr>
<td></td>
<td>PERSG</td>
<td></td>
<td>Employee Group</td>
</tr>
<tr>
<td></td>
<td>PERSK</td>
<td></td>
<td>Employee Subgroup</td>
</tr>
<tr>
<td></td>
<td>VDSK1</td>
<td></td>
<td>Organizational Key</td>
</tr>
<tr>
<td>PLOG (Personnel Planning)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PLVAR</td>
<td></td>
<td>Plan Version</td>
</tr>
<tr>
<td></td>
<td>OTYPE</td>
<td></td>
<td>Object Type</td>
</tr>
<tr>
<td></td>
<td>INFOTYP</td>
<td></td>
<td>Infotype</td>
</tr>
<tr>
<td></td>
<td>SUBTYP</td>
<td></td>
<td>Subtype</td>
</tr>
<tr>
<td></td>
<td>ISTAT</td>
<td></td>
<td>Planning Status</td>
</tr>
<tr>
<td></td>
<td>PPFCODE</td>
<td></td>
<td>Function Code</td>
</tr>
<tr>
<td>S_USER_GRP (User Master Maintenance: User Groups)</td>
<td>CLASS</td>
<td></td>
<td>User group in user master maintenance</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
</tbody>
</table>
Business Partner End of Purpose (EoP) Check in Human Resources

Human Resources provides an EoP check to determine whether Employee Business Partner is still relevant for business activities in the application or can be blocked.

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Application Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUCP</td>
<td>Central Business Partner: Employee</td>
</tr>
</tbody>
</table>

**i Note**
For more information, refer to [2142308](#).

### 7.19.1.2 Design Constraints

**Workplace Address Data**

If infotype 105, System User Name (SY-Unname) 0001, is maintained for the employee and if workplace address is synchronized, the user will be converted to type 04 (Identity with Workplace Address).

If user assignment is removed (infotype 105, subtype 0001 is removed for the employee), the user needs to be unassigned from the business partner by running the report RSUID_REMOVE_FALSE_BP_ASGN (after the employee synchronization report has been executed). Refer to note [2568251](#) for more information.

If user is converted to 02 or 04 (IDADTYPE), workplace address or address section will not be editable in user administration transactions like SU01.

### 7.19.2 FAQ

For more information about the FAQs, refer to the SAP Note [2409229](#).

### 7.19.3 Related Notes

- [2265093](#) - S4TWL - Business Partner Approach
- [2570961](#) - Simplification item S4TWL - Business User Management
- [2340095](#) - S4TWL - Conversion of Employees to Business Partners
- [2273108](#) - S4TWL - General HCM Approach within SAP S/4HANA
- [2383879](#) - S4TWL - Java-based ESS and MSS not available in Compatibility Mode
- [2393462](#) – All changes in 1610
- [2241838](#) – Limitations to PRAA transaction in S/4HANA
Follow-Up Activities for SAP S/4HANA for Central Procurement

Integration in SAP S/4HANA

This section describes the integration of an on-premise SAP S/4HANA system or SAP S/4HANA Cloud system with some other enterprise resource planning systems in your system landscape (for example, SAP S/4HANA OP, SAP S/4HANA Cloud, or SAP ERP) to offer centralized procurement processes over your entire system landscape. With Central Procurement, the on-premise SAP S/4HANA system or SAP S/4HANA Cloud system acts as a hub system and the enterprise resource planning systems act as connected systems.

Central Procurement enables you to manage the procurement processes of several connected systems from a single-source system. The hub system can be operated centrally by the company headquarters, whereas the respective connected systems are operated by the subsidiaries. Using this approach, you can simplify certain aspects of your procurement processes. For example, employees from different subsidiaries raise requests to procure materials by creating self-service purchase requisitions in the hub system of the company headquarters. When employees create purchase requisitions, they are only able to select materials from the subsidiary that they belong to. They are also provided with information about available sources of supply, for example, contracts and purchasing info records, for the selected material. After an employee has completed and saved the purchase requisition, it goes to the approval process. After the approval process is completed, the purchase requisition is replicated to the respective connected system of the subsidiary that the employee belongs to. After successful replication, a purchase order is created automatically to procure the material, and the number of the purchase order is updated back to the self-service purchase requisition.

If you want to use the SAP S/4HANA system that you have installed as one of the connected systems for Central Procurement, then the following information is relevant to you.

The integration of the hub system with SAP S/4HANA system as the connected system is supported in on-premise and cloud integration scenarios. If you want to integrate the hub system with the SAP S/4HANA system as the connected system, you must install the HUBS4IC add-on.

Integration Scenarios

This section describes the integration scenarios that use SAP S/4HANA system as a connected system for Central Procurement.

This section is relevant only if you are using the SAP S/4HANA system as the connected system when using Central Procurement. If you consider your current SAP S/4HANA system installation to be the connected system, continue reading.
You can use your current integration based on SAP S/4HANA to implement SAP S/4HANA for Central Procurement. If you are an SAP S/4HANA customer also using SAP ERP, you can continue to use SAP ERP.

Prerequisites

To open the connectivity of the hub system and the connected systems, an integration add-on must be installed for each of the connected systems. The add-ons for SAP ERP and SAP S/4HANA system are as follows:

- **HUBS4IC**
  This add-on is used to integrate the hub system with an on-premise SAP S/4HANA system as the connected system.

- **HUBERPI**
  This add-on is used to integrate the hub system with SAP ERP system as the connected system.

Integration Scenarios

The following integration scenarios are available:

**On Premise (OP)**

This scenario is relevant if you want to connect one or more SAP ERP or SAP S/4HANA systems as the connected systems to the hub system to carry out procurement processes in an OP environment.

ℹ️ **Note**

Depending on the support pack that you install, you get different functionalities. For example, if you install SP02 of HUBERPI, it includes the functionality for central contracts and central requisitioning but if you install SP00 of HUBERPI, you get the functionality for central requisitioning only.

Make sure you read the availability matrix contained in the release information note 2491065 for more information on the functionalities available with different support packages for HUBERPI.

For more information on the functionalities available with different support packages for HUBS4IC, see release information note 2573672.
**Deployment Option: On Premise**

**Hybrid - SAP S/4HANA Cloud and SAP S/4HANA back-end (OP)**

This scenario is relevant if you want to address your strategic procurement needs in the cloud and at the same time continue to maintain OP investments for operational procurement.

**More Information**

General Instructions to Install Add-ons

Installation Guide for SAP S/4HANA 2021
Installation Follow-Up Activities
7.21 Follow-Up Activities for Agricultural Contract Management

Once the installation is complete, you need to perform the following activities for Agricultural Contract Management (ACM):

Delivery Customizing

You must copy the delivery customizing for ACM from client 000 to your system-relevant clients. To compare the customizing content contained in these clients, you can execute the transaction Customizing Cross-System Viewer (SCU0). For ACM, the following application components are relevant:

- LO-AGR-LDC
- LO-AGR-APP
- LO-AGR-STL
- LO-AGR-CC

You can find the Customizing structure for Agricultural Contract Management in SAP Reference IMG (transaction SPRO) under Logistics - General > Global Trade Management > Agricultural Contract Management.

Important SAP Notes

Make sure that you read the following SAP Notes before you start implementing Agricultural Contract Management (ACM).

List of SAP Notes relevant to Agricultural Contract Management

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2965612</td>
<td>Reference Program for Mass Creation of Load Data Capture using Parallel Processing</td>
<td>This note provides information about the reference program for mass creation of Load Data Capture (LDC). To improve performance, LDC data are grouped and created using parallel processing.</td>
</tr>
<tr>
<td>2954877</td>
<td>ACM: S/4HANA OP 2020 FPS0 and Above Post Conversion Corrections of Legacy Contracts</td>
<td>This note provides information about the post conversion corrections of legacy contracts that enable repricing in legacy contracts by updating the legacy values for quantity distribution routine.</td>
</tr>
<tr>
<td>SAP Note Number</td>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>2952195</td>
<td>ACM relevant transactions not working correctly due to missing customizing after S/4HANA Conversion or Upgrade</td>
<td>This note provides information about how you can copy the missing delivery customizing from client 000 to your system-relevant clients.</td>
</tr>
<tr>
<td>2951709</td>
<td>Unexpected issues related to data type changes in ACM CDS Views I_CtrPnLValueCube, I_PnLNewActivityDeltaVal and I_PnLNewActyDeltaValCube</td>
<td>This note provides information about how you can change data type to increase the length and precision of elements used in the relevant ACM CDS views.</td>
</tr>
<tr>
<td>2926465</td>
<td>ACM: System Conversion or upgrade to S/4HANA OP2020 FPS0 and above with SDM conversion is still in progress</td>
<td>This note provides information about activities required for system conversion or upgrade to S/4HANA 2020 FPS0 in case SDM conversion is still in progress.</td>
</tr>
<tr>
<td>2858528</td>
<td>ACM: Master SAP Note for System Conversion from ECC to S/4HANA or Upgrade from S/4HANA Lower Release/Feature Pack to Higher Release/Feature Pack</td>
<td>This master note provides information about all the valid combinations of source and target releases for conversion or upgrade, along with the notes that are relevant for each source/target combination.</td>
</tr>
</tbody>
</table>

**i Note**

This is a mandatory note for all ACM customers who are performing a system conversion or an upgrade to S/4HANA 2020 FPS0 where SDM conversion is taking place during uptime.
<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1909425</td>
<td>SFW- Activation error in Dictionary: clear up the inconsistencies</td>
<td>This note provides information about how you can copy missing delivery customizing in your relevant client by activating all the switch BC sets that are associated with the ACM switch.</td>
</tr>
<tr>
<td>3025395</td>
<td>Contract Status Configurations for Contract Closure and Amendment Process</td>
<td>This note provides information about the contract status configuration steps that are a prerequisite for the contract closure and contract amendment functionalities.</td>
</tr>
<tr>
<td>3150571</td>
<td>Master Note for CDOTE Functionality in Maintain ACM Pricing app</td>
<td>This note allows you to enable the CDOTE functionality in the Maintain ACM Pricing app.</td>
</tr>
</tbody>
</table>

### 7.21.1 Integration with Oil & Gas and Commodity Management

Agricultural Contract Management (ACM) is delivered as part of Oil & Gas (IS-OIL) and is integrated with Commodity Management (CM). This integration enables the user to use various CM functions for the commodities processed based on the ACM scenarios.

#### Integration

To activate the ACM business function (/ACCGO/BF_ECC) the following IS-OIL business functions must be activated as a prerequisite:

- **IS-OIL business functions:**
  - BUSINESS_FUNCTION_BASIS_COM
  - COMMODITY_MGMT_&_BULK_LOGISTIC
  - LOG_COMMODITY_TRANSPORT_MGMT_5

The integration with CM has been achieved through incorporation of various CM switches in the ACM business function /ACCGO/BF_ECC.
### 7.21.2 Integration with Prepayment Agreements

Agricultural Contract Management (ACM) is integrated with Prepayment Agreements (CA-PPA). This integration enables the user to use various Prepayment Agreements functions in the agribusiness context.

**Integration**

To enable the integration between ACM and Prepayment Agreements (CA-PPA), the following switches must be activated:

- /ACCGO/SWITCH_PPMG
- SWITCH_PPMG

The following figure provides an overview of the integration between ACM and CA-PPA in the SAP S/4HANA Core landscape.
7.22 Follow-Up Activities for Prepayment Agreements

Once the installation is complete, you need to perform the following activities for Prepayment Agreements (CA-PPA):

**Delivery Customizing**

You must copy the delivery customizing for Prepayment Agreements from client 000 to your system-relevant clients. To compare the customizing content contained in these clients, you can execute the transaction *Customizing Cross-System Viewer* (SCU0). For Prepayment Agreements, the application component CA-PPA is relevant.

You can find the Customizing structure for Prepayment Agreements in SAP Reference IMG (transaction SPRO) under [Cross-Application Components Prepayment (CA-PPA)]

7.23 Follow-Up Activities for Policy Management

With Policy Management (FS-PM), you can map the whole life cycle of an insurance contract, starting from the creation of an application, through policy issuance and ongoing contract maintenance, right up to the termination of the contract.

**SAP Notes for the Installation of Policy Management**

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>3081482</td>
<td>Release Information Note (RIN) for Policy Management and Claims Management in SAP S/4HANA 2021</td>
</tr>
</tbody>
</table>

**Activating Business Function /PM0/INS_FSPM**

To use the functions of Policy Management, you must activate the /PM0/INS_FSPM (*Insurance, SAP Policy Management*) business function (with transaction SFW5, [INSURANCE /PM0/INS_FSPM]).
Connecting a Product Engine

Each policy is based on a product that is defined in a product engine. For this reason, Policy Management for Insurance is always connected to a single product engine, which is usually one of the following:

- msg.PMQ (see also Follow-Up Activities for Insurance Product Engine msg.PMQ [page 86])
- SAP Product, Quotation and Underwriting Management (FS-PRO)

**i Note**

Only one product engine can be connected to Policy Management for Insurance. It is not possible to integrate multiple FS-PRO systems, or multiple msg.PMQ systems, with Policy Management for Insurance.

Customer Variants for Group Insurance Features

If you want to use Group Insurance Features in Policy Management you have to check if the corresponding customer variant is activated in Policy Based Technology (PBT). To do so proceed as follows:

1. Start transaction /PM0/3FW_START.
2. In the context menu of Workplace, choose Customer Variant.
3. Enter application 00001 for FS-PM.
4. Check if the customer variant PMG is available.
   If it is not there proceed as follows:
   1. Add the customer variant PMG and assign PM0 as the previous customer variant.
   2. Change the customer variant MVA (for Auto line of business) by assigning PMG as the previous customer variant.
   3. Select the Active checkbox for the customer variant MVA.
   The Customer Variants screen should look like as follows:

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Customer Variant</th>
<th>Active</th>
<th>Previous Customer Variant</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PM0</td>
<td>not active</td>
<td>&lt;No entry&gt;</td>
</tr>
<tr>
<td>2</td>
<td>PMG</td>
<td>not active</td>
<td>PM0</td>
</tr>
<tr>
<td>3</td>
<td>MVA</td>
<td>X (= active)</td>
<td>PMG</td>
</tr>
</tbody>
</table>

5. If you have an own customer variant, add this customer variant with the following settings:
   - Make sure that this and only this entry is selected as Active.
   - Enter MVA as the previous customer variant.
7.24 Follow-Up Activities for Insurance Product Engine msg.PMQ

You can use the product engine msg.PMQ to define and calculate insurance products. msg.PMQ consists of the following:

- **PMQ.Designer**
  PMQ.Designer is a desktop application that has to be installed on the client computer of a PMQ.Designer user.
  For the distributed development, as well as for the central storage of the product data, a version control system is also required, which is not part of the shipment of PMQ.Designer. It has to be installed and administered separately.
  PMQ.Designer generally supports all version control systems that are capable of being integrated into Eclipse.
  For the operation, we recommend a version control system on the basis of Apache Subversion (SVN).

- **MSGPMCON**
  The msg.PM connection (MSGPMCON) is the link between msg.PMQ and Insurance Policy Management (FS-PM) as part of SAP S/4HANA.
  The main tasks of MSGPMCON are the following:
  - Management of the product data for the import into In-Force Business Configurator (IFBC) of FS-PM
  - Forwarding of calculation requests from FS-PM to TOMATOSJ

- **TOMATOSJ**
  TOMATOSJ has to be installed as a software component on SAP HANA XSA. Installation and administration is handled by mechanisms of the XSA platform.
  During the installation, a customer-specific configuration file can be specified to adapt several default values.

For more information, see the attachments in SAP Note 2635864.

7.25 Follow-Up Activities for Transportation Management

After the installation, you need to carry out the following activities for Transportation Management (TM):

- In order to use automatic planning with the optimizer, you must install the SAP SCM Optimizer. In order to use detailed mixed package building, you must install the Package Building Optimizer. For more information, see SAP Note 1686826.

- Check whether all services in the following SICF paths have been activated (transaction SICF):
  - /default_host/sap/bc/webdynpro/scmtms/* (all TM WebDynpro apps)
  - /default_host/sap/bc/ui5_ui5/scmtms/*
  - /default_host/sap/bc/bsp/gntlb
  - /default_host/sap/bc/bsp/scmtms/*
  - /default_host/sap/apc/sap/fpm_apc
  - /default_host/sap/public(bc/ui5_ui5/ILMRWC
For successful installation, always check the SAP Note 3083725 (SAP S/4HANA 2021 Supply Chain for Transportation Management - Release Information) for the most current implementation details.

7.26 Follow-Up Activities for Production Planning and Detailed Scheduling (PP/DS)

In order to use optimizers in PP/DS (Production Planning Optimizer or PP/DS Optimizer), you must install the SAP SCM Optimizer.

For more information, see SAP Note 1686826.

7.27 Follow-Up Activities for Data Quality Management, version for SAP Solutions

After installation, several follow-up activities are necessary to set up Data Quality Management, version for SAP Solutions.

Your follow-up activities depend on whether you are using SAP HANA smart data quality, SAP Data Services, and/or SAP Data Quality Management, microservices for location data as the underlying engine.

For more information, see the product assistance.

7.28 Follow-Up Activities for Service

After the installation, you need to carry out the following activities for Service:

Activate Internet Communication Framework (ICF) Services

For information about the ICF services that you have to activate for WebClient UI apps, see the product assistance for SAP S/4HANA on the SAP help portal at https://help.sap.com/s4hana_op_2021 [Enterprise Technology] [SAP Fiori] [SAP Fiori Overview] [Implement SAP Fiori Apps] [Implementation Tasks on Back-End Components (App Implementation)] [Configuration Steps for SAP GUI for HTML Transactions, Web Dynpro Applications, and WebClient UI Applications] [Activate ICF Services of WebClient UI Apps]

SAP Note 2825458 contains information on the services required for WebClient UI apps.
Object Navigation


Specific Customizing Settings for In-House Repair

When you set up In-House Repair in Customizing for Service, you must follow the instructions outlined in the Customizing section under In-House Repair in addition to the generic settings for Service. This ensures that In-House Repair operates as expected.

7.29 Troubleshooting

Unable to Create New Clients

If you are unable to create new clients in transaction SCC4 or SM30 (table T000) because the New Entries button is missing, see SAP Note 2140167.
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:
- Links with the icon: You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to this:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP’s gross negligence or willful misconduct.
- Links with the icon: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP’s gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities, genders, and abilities.